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1. Introduction

1. Introduction

1.1  Smart Control Network V4.1 Overview

111

112

Smart Control Network V4.1 is a call manager application with support for contact
management, scheduling and call logging. It also gives limited support for email and
browsing.

Station Setup Services

You can control your station parameters using these services. You can set/reset
DND (Do Not Disturb), Call Forwarding, etc, using the simple user interface
provided.

Call Control Services

You can access all the basic and extended services of your Samsung DCS Key
Telephone System using Smart Control Network V4.1. You can make calls, answer
call, release calls and manage multiple calls at your desktop. You can also establish
multiparty audio conference through Smart Control Network V4.1 without having
to remember any PBX feature codes. Some special features like speed dialling and
continuous dialling are supported.

1-1
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1.1.3

114

1.15

Directory Services

Smart Control Network V4.1 allows you to maintain multiple phone books of your
choice to keep track of your contacts. You may also print all your contacts’
information in four different formats. Smart Control Network V4.1 directories
provide Drag and Drop functionality for easy call control. You can import your
existing database from your current Personal Information Manager (PIM)
application—ACT! 2.0 or ACT! 4.0 for Windows, PS2000 or Microsoft OutLook—
into Smart Control Network V4.1. The Directory Services feature also allows Smart
Control Network V4.1 to identify the caller if the contact information is available in
Smart Control Network V4.1 or other applications using a Dynamic Data Exchange
(DDE) mechanism.

Scheduler Services

Smart Control Network V4.1 allows you to schedule a telephone call or activation
of some of the station setup options for execution at some later point of time. A note
that will show at the time of execution may be entered to explain why this call or
feature was scheduled. A pop-up window gives you the option to cancel any
scheduled item at the scheduled time of execution or to change the time of execution.

Call Log Services

Smart Control Network V4.1’s Call Log maintains a record of all incoming and
outgoing calls from the keyset while the application is active. Call log records
contain a Notes field for recording information about a particular call and a
Keyword field to enable the logs to be searched. Smart Control Network V4.1
allows you to print individual Call Log records, selected Call Log records or an
entire Call Log. This will allow you to archive hard copies of the logs for later
perusal.
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2a. Installing Smart Control Network

For DCS

2a.1 System Requirements

2a.1.1

Samsung Smart Control Network V4.1 software have two installation options. One
is the Server Installation mode and the other is the Client installation mode. When
you select the Server Installation, Smart Control Network V4.1 Install wizard will
try to install two packages on your system. In case of the Client Installation Mode, it
will try to install only Client Software. According to each installation mode, System
requirement is different. See the below.

Computer Hardware & Operating System & Switch System

To Install Smart Control Network V4.1 as the Server Installation Mode. (at
Telephony Server)

o Computer System : Windows NT Server 4.0 - Service Pack 4 or later and this
NT system must belong to a domain or have Primary Domain Controller.

« Samsung DCS Key Telephone Series with appropriate software version for CTI
Link

o Make a connection between NT Server and Samsung Key Telephone System
with SIM or Serial Cable for CTI Link according to the CTI Link Type.

« Log on as administrator of NT Server System
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To install Smart Control Network V4.1 as the Client Installation Mode. (at
Telephony Client)

o Computer System : Windows NT Server / Workstation 4. 0 — Service Pack 4 or
later, Windows 95 / 98
—must run the “Client for Microsoft Networks”,
—have “User-level access control” enabled,
— have “File and printer sharing for Microsoft Networks” enabled.
— Refer to the Windows 95 / 98 help file for details on how to enable
these features.

« FEach Client Users: must be logged on using a valid domain account to
Telephony Server.
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2a.2 How to Install

23.2.1

Installing on Windows NT Server as the Server Installation Mode

Presetting the NT Server System to install the Smart Control Network V4.1

Please verify that your Samsung DCS Key Telephone System is operating on
current firmware. You may want to contact your Samsung Representative to
determine whether the firmware you are using must be updated.

¢ Setting up the CTI Link Hardware

This chapter explains how to set up the CTI link between the Samsung DCS Key
Telephone System and the Telephony Server (Windows NT Server or Windows NT
Workstation).

1. Establish a connection between the NT system and the SIM using the serial
cable. The male connector of the cable should be connected to the SIM and the
female connector of the cable to one of the serial ports of the NT system. Please
record the serial port number to which you are connected. This information is
useful for configuring the telephony service provider.

With Some Samsung Key Telephone systems, you can also establish a connection
between the NT system and the Samsung Key Telephone System using a serial
cable only without a SIM. Contact the Samsung Key Telephone System Reseller for
more information.

For example:  DCS SIM connection only
DCS 50si / Compact |l Serial connection only
DCS 400si SIM and serial cable Connection.
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Verify that the serial port IRQ selected is available and enabled in CMOS. COM 1
and COM 3 use IRQ 4. COM 2 and COM 4 use IRQ 3.

2. Establish a connection between the SIM and the Samsung DCS Key Telephone
System DLI card using the telephone line cord which has RJ-14 connectors at
both ends.

U TS
i

Figure 2a-1

3. Using the Samsung DCS Keyset, program MMC 804 to set SysIOPort and
Service to the following values:

SysIOPort - 2 (assuming that you are using COM 2)
Service - CTI-SMDR (You can use other types: CTI, CTVUCD and CTI/S/U)

Configure the System I/O settings for the desired port to connect to the SIM

using MMC 804.
SERVICE CTI-SMDR
BAUD RATE 9600 or 19200
CHAR LENGTH 8
PARITY NONE
STOP BIT 1
RETRY COUNT 5
WAIT TIME 03000 msec.

2a-4




2a. Installing Smart Control Network For DCS

4. Using MMC 311 set SIM parameters (using SIM only).

SIM TYPE: DTE
CALL MODE: MANUAL
ANS MODE: MANUAL
AUTO BAUD: ON

DTR CHECK: ON
ECHO: ON
PROTOCOL.: V110
SPEED: 9600 or 19200
CHAR LENG: 8 Bits
PARITY BIT: NONE
STOP BIT: 1

CONFIGURING TAPI 2.1 as Telephony Server

This chapter explains the procedure for Tapi2.1 configuration on the Telephony
Server. If you use a Microsoft Windows N'T Workstation as the Telephony Server,
you need not read this chapter.

« Configuring the Telephony Server

1. Select Run from the Start menu on the Telephony Server.

Run HE

Tuvpe the name of a program, folder, or decumnent, ahd
Wwindows will open it for you.

=

¥ | Buirin Separate Memon Space

ak. I Cancel | Browse. .. I

Figure 2a-2
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2. Type temsetup and click OK. The following help screen appears:

Telephony Server/Client Setup Help E
Uszage is:

SERVER SETUR
TCMSETUP [#Q] /5 [/M] domaintusername [password] [managamentdlist]

domainhuzername is the full domain ahd usemanne of administrative TAP] account
paszzword is the password for that account

managementdlllizt iz the optional list of DLLs. The DLL names are delimited with double quotes (]
A - will cauze meszage boxes to not be displayed during setup
/M indicates the username does not have a password. |n this case, the password parameter iz not needed.
SERVER DISABLE
TCMSETUR [/Q3] /5 /D
CLIEMT SETUF
TCMSETUR [AQ] [#] /C remoteservername
remoteservernanme is the machine name of the telephony server
A - will cauze message boxes to not be displayed during setup
M- connectionless callbacks. glower but more efficient
CLIEMT DISAELE
TCMSETUP [/Q] /C /D

Figure 2a-3

You can see the options that can be used with TCMSETUP on the screen.

3. Click Start and Run and type
TCMSETUP /S domain‘\username password.

If the Telephony Server is a PDC, domain represents the domain name. If the
Telephony Server is a standalone server, domain represents the computer name
of the Telephony Server.

Username is an NT user account with Administration Privileges.

Password is the password of the NT User account.
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If the setup is successful, the following dialog box will appear:

TAPI Administration Setup

TAP| Server successfully set up.

Figure 2a4

Click OK.

2a.2.2  Installing on Windows 95/98/NT as the Client Installation Mode

Presetting the Client System to install the Smart Control Network V4.1

CONFIGURING TAPI 2.1 as Client
o Configuring the Telephony Client

1. Select Run from the Start menu on the Telephony Server or Telephony Client.
Run

Type the name of a program, folder, or document, and
windows will oper it for pou.

=

I¥ | it Separate fdemen Space

ok I Cancel | Browsze... |

Figure 2a-5

Telephony Client System can be the Microsoft Windows NT Server, Workstation,
Windows 98 and Windows 95. In additonally, Telephony Client System have to be
logged on to the Telephony Server as NT Server’s User. For detailed information
about Tapi 2.1 configuration, refer to the Microsoft Web Site.

2a-7




Smart Control Network Version 4.1 User Manual
I

2. Type TCMSETUP and click OK. The following help screen appears:
]

Usage is:
CLIEMT SETU%
TCMSETUR [M] [[%] M'C remoteservername [remokteservernamez ... ]
remoteservername is the machine name of the telephony server
12 - will cause message boxes to nok be displayed during setup
1% - connection-oriented callbacks {default is connectionless), For lossy netwarks
CLIEMT DISAELE

TCMSETUR [fQ] /C /D

Figure 2a-6

3. Click Start and Run and type
TCMSETUP /C remoteservername where remoteservername is the computer
name of the Telephony Server. An example is shown below:

run 2

Twpe the name of a program, Folder, document, ar
Internet resource, and Windows will open it For yau.

Opent I temsetup o chiserver j

Ok I Cancel | Browse. .. |

Figure 2a-7

Click OK.

On NT Workstation Clients you must be logged in locally on the NT workstation
as an administrator for TCMSETUP to work.
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4. The TAPI Administration Setup dialog box should appear indicating that the
TAPI Client was successfully installed.

TAPI Administratiol x|

TAPIL Client successfully set up,

Figure 2a-8

Presetting for Server and Client Installation Mode is now completed.

Installing Smart Control Network V4.1 on each System

« Log on you system as administrator or Domain User
- Install on Windows NT Server as Server Mode : Log on administrator
- Install on Windows NT Server/Workstation as Client Mode: Log on

administrator

- Windows 95/98 as Client Mode : Log on Domain User.

o Insert Smart Control Network V4.1 Install CD. Setup.exe will be run
automatically.

« Ifnot, Run E:\Setup.exe (where E: is the CDROM drive)

Follow the instructions in the Setup program. These instructions are described
below.
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Click the Next button in the Welcome dialogue box to continue Setup or the
Cancel button to exit Setup.

—_

Note for Windows 95 Users: If you do not have Microsoft TAPI 2.1 installed
on your system, you will be given the option to install TAPI 2.1 before
installing Smart Control Network V4.1. Select Yes to install TAPI 2.1 and
proceed with Smart Control Network V4.1 installation. If you select No, Smart
Control Network V4.1 Installation will be aborted.

Question \ [ <]

Microgoft TAPI 2.7 for Windows 35 should be installed befare Smart Contral Metwark. can be installed on your computer.
Do pou want the Smart Control Netwark Setup ta run TAPL 2.1 setup for you?

Figure 2a-9

Welcome to the Smart Contral S etup program.  This
program will install Smart Control on your computer.

Itiz strongly recommended that vou exit all windows programs
befare running this Setup program.

Click Cancel to quit Setup and then cloze any programs you
hawe running. Click Mewt to continue with the Setup program.

WARMIMG: This program is protected by copyright law and
international treaties.

Unauthonzed reproduction or distribution of thiz program, or any
partion of it, may result in zevere civil and criminal penalties, and
will be prosecuted to the maximum extent pozzible under law.

Cancel |

Figure 2a-10
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2. Read carefully the Software License Agreement (Figure 2a-11). After reading
the Software License and if you accept all the terms of it, click Yes Button.

Software License Agreement

Flease read the following Licenze Agreement. Press the PAGE DOWH key to see
the rest of the agreement.

For Srnart Control

Foftvare License Soresment & Limited ' aranty ﬂ
Samsung Electronics Co., LTD.

IMPORTAMT, READ CAREFULLY :

Thiz Samzung End-User Licenze Agreement [ELULA) iz a legal binding agreement

betweeh you (either an individual or an entity] and Samzung for 5 amsung software

product identified above, which includes computer software and may include printed

material, and "onling” or electronic documentation ["SOFTWARE"). By instaling. using

the SOFTwARE , pou indicate your acceptance of thiz Samsung License dgreement. |f

vou do hot agree to the terms of this License Agreement, please do not install or use the
enclozed SOFTWARE. ﬂ

Do you accept all the terms of the preceding License Agreement?-Jf you choose No, Setup
will cloze. To install Smart Control Metwork., you must accept this #5reement.

< Back Yes Mo |

Figure 2a-11

3. Next, You can see the next Dialog Box. Select the install mode you want.

Select a Smart Control Hetwork

Setup can install the Smart Control Metwaork for Server or Client.
Chonse the optionz listed below which vou would like to install.

1 Smart Control Metwork, for Server

" Smart Control Network for Client

< Back I Mest » I Cancel

Figure 2a-12
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4. You can see the User Information Dialog Box. Enter name and company.
Click the Next Button.

t Information x|

Pleaze enter pour name and the name of the company for whom
pou work,

Mamne: IETI

LCompany: |Samsung Electronics Co., Ltd)

< Back I Mext > I Cancel

Figure 2a-13

5. Choose the destination directory where Smart Control Network V4.1 will be
installed.

Chooze Destination Location (%]

Setup will install Smart Contral Metwork, in the following falder.
Ta install ko this folder, click Mext.

Ta install ko a different folder, click Browse and select anather
falder.

‘You can chooze not to install Smart Control Metwork by clicking
Cancel to exit Setup.

" Destination Folder

C:A.. vSmart Contral Mebwark Browse. . |

< Back Cancel |

Figure 2a-14
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6. The following dialogue box appears. Click Next after entering the program
folder name.

Select Program Folder (%]

Setup will add program icons to the Program Faolder listed below.
‘Y'ou may type a new folder name, or select ane from the existing
Folders list. Click Mest to continue.

Program Folders:

Ezisting Folders:

liveCaster -
MGA NT PowerDesk _I

Microzoft Reference
Microzoft Visual Studio 6.0 J

MetShow Services
Morton Antirus
Phonetd ax

Smart Control

Snart Control Mebwork

< Back I Mest » I Cancel

Figure 2a-15

If you try to install the Smart Control Network without uninstalling the previous
version, you will see the following dialog box.

Question

@ Do you want to ovenwrite wour Directory and Call Log database files?

Figure 2a-16

Select Yes or No. If you select Yes, your previous Contact Database file is
deleted and the new empty database file is overwitten.
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Files are copied to your selected directory and the ODBC is configured. The
following dialogue box appears. Click Next button.

Information [ x|

Setup haz copied the files successfully.

MNow you can configure zome of the application and the
telephony diiver parameters. [If you have selected that
component.]

Figure 2a-17

7. The following Call Notification Options dialogue box appears. Enter your
options. While using Smart Control Network V4.1 you can change the call
notification options by selecting the Call Notification... item on the Option
menu.

Call Hotification Ophions

Flease zelect the Smart Control Call Hohfication Options.

— Dizplay Call D etailz

™ Far Incoming Internal Calls
™ For Outgoing Calls

— On Incoming Call
r Bring Smart Contral ko Front
™ Play sound for Incoming Call

I Browse |

Figure 2a-18
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Then, select the language which you want your resources in. You can change the
language anytime after you finish setup, using “SCN Language Selection.exe”. This
program is newly added Smart Control V4.1 International Package.

Be sure that the Smart Control is not running when you try to launch SCN Language

Selection.exe.

What language would vou like your resources in?

|Mone Selected |

Cancel |

Figure 2a-19

8. Change the dialing properties, if needed. The dialogue box below shows the

properties.

Dialing Properties

My Locations I Telephony Drivers I

Hew. .. | Eemovel

Area code:
IKorea [Republic af] j |2

| am dialing frann:
7 -

Jevw Location

| am in thiz country/region:

Area Bade Hules.. |

[ 7] %]

—When dialing from here

To access an outside line:

For lacal calls, dial I

For long distance callz, dial Ig

I jv

Dial using: @ Tone dial ¢ Pulse dial

[~ Tadisable call waiting, diak

" For long distance callz, use this calling card:

|Mane [Direct Dial]

7| CalingCard... |

oK I Cancel

Apply

Figure 2a-20
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9.  When you click the OK button on the above dialogue box, one of the next two
types dialogue box appears confirming that Smart Control Network V4.1 has
been installed successfully.

Case 1 : Server Mode Installation

Setup Complete \

Smart Contral Metwork 4.1 Setup has completed.
Choosge the options you want below

™ 1 would like to view the README file;

¥ | would like to install the DCS TSP,

Click. Finish to complete Smart Control Metwork Setup.

< Back I Finizh I

Figure 2a-21

Case 2 : Client Mode Installation

Setup Complete

Smart Contral Metwork %4.1 Setup has completed
Choosge the options you want below

™ 1 would like to view the README file;

[~ Launch Smart Con%l M etwark 4.1 M ow

Click. Finish to complete Smart Control Metwork Setup.

< Back I Finizh I

Figure 2a-22
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When you try to install Smart Control Network V4.1 as Client Installation Mode,
Installation is completed at this step. How ever, If you try to install as Server
Installation Mode, Install Shield will go on next step : Samsung TSP 2.1 Installation
Step.

Click Finish button to complete the Setup.

The following Step is only for Server Mode Installation.
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2a.2.3  Installing the Samsung TSP Version 2.1 for DCS Series

The installation wizard will start automatically.

Important Hotice

L)

Thig Setup must be wn on Windows MT 4.0 with SERYICE PACK 4 or higher.

Fleaze shut down all other applications running and then
you may continue with Setup.

Figure 2a-23

Step 1. Click OK. The following Welcome dialog box appears:

Welcome

Welcome to the DCS Telephony Service Provider
Setup program. This program will install DCS
= Telephony Service Provider on your computer.

Itiz strongly recommended that vou exit all windows programs
befare running this Setup program.

Click Cancel to quit Setup and then cloze any programs you
hawve running. Click Mewt to continue with the Setup program.

WARMIMG: This program iz protected by copyright law and
international treaties.

Unauthonzed reproduction or distribution of thiz program, or any
partion of it, may result in zevere civil and criminal penalties, and
will be prosecuted to the maximum extent pozzible under law.

Cancel |

Figure 2a-24
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Step 2. Click Next. The Choose Destination Location dialog box appears:

Choose Destination Location E

Setup will ingtall DCS Telephony Service Provider in the following
folder.

Ta install ta this folder, click Mext.

To install to 4 different folder, click Browse and select another
folder.

“r'ou can choose not to install DCS Telephony Service Provider
by clicking Cancel ko exit Setup.

C:4. ADCS Telephony Service Provider Browse... |

" Destination Folder

< Back Cancel |

Figure 2a-25

Step 3. Click Next to select the default Destination Folder C:\Program
Files\DCS Telephony Service Provider. The Select Program Folder
dialog box appears:

Select Program Folder (%]

S etup will add program icons to the Program Folder listed below.
“Y'ou may type a new folder name, or select one from the existing
Folders list. Click Mext to continue.

Program Falders:

Dialogic: Sy
MGANT PowerDesk
Microzoft Yisual Studio 6.0
Smart Office Client

Smart Office Professional

Windows MT 4.0 Option Pack

< Back I Mext > I Cancel

Figure 2a-26
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Step4.  Click Next to accept the default Program Folder DCS Telephony Service
Provider. Files will be copied to this folder.

When installation has finished, the Copy Complete dialog box appears:

Copy Complete (%]

Setup has finizhed copying files to your system. Mow you
can configure your COM Port gettings for the CTI- Link of
DCS Telephony Service Provider.

Click Mext Button to proceed with configuration.

[Eance] |

Figure 2a-27

Step 5. Click Next. The Communication Settings dialog box appears:

—COM Part Settings for CT1 link

Com. Part IEDM1 YI = Through SIM
& sing Direct 5 erial Connection
Baud Fate 3600 7
—SMDR Logaging Options
Data Size IS 'I
1 -

| Connect to DCS

I Logto COM Port ICUM2 'I
Stop Bits I I
I Logte MamedPipe : "DCSSMDRAPipe

Ok LCancel

About |

Figure 2a-28
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There are three setting options:
¢ COM Port Settings for CTI link: The default port is COM 1.

o Connect to DCS: The default connection type is Through a SIM.
The connection type depends on the Samsung Key Telephone System being
used, as follows:,
o DCS : Through SIM only
o DCS50si/CompactIl : Using Direct Serial Connection only
o DCS400si : Through SIM or Using Direct Serial Connection

« SMDR Logging Options
The Samsung TSP Version 2.1 for DCS Series can display the DCS system’s
SMDR data in three ways.

o Protocol Monitor - This program is installed with the Samsung TSP Version
2.1 for DCS Series. Locate and double click “PMonitor.exe”, or use the
Windows Start button to open the “DCS Telephony Service Provider” program
folder and click “DCS-CTI Link Monitor” to run the program. This is the
default option. Do not check any check box.

e Logto COM Port - If you select this option, the Samsung TSP Version 2.1 for
DCS Series sends the SMDR data from the switch to the specified port. You
can use SMDR data for your own purposes with this option. You cannot use the
same port for the CTI Link Port and SMDR Output Port. If you select the same
port, you will receive a warning message and your action will be ignored.

e Log to Named Pipe: “DCSSMDRPipe” - Using a Pipe, SMDR data can be
printed. You can see this data using “SMDRLOg.exe” installed with the
Samsung TSP.
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Step 6.  Complete the connection from the DCS to the Telephony Server . These
values must match those configured for the System I/O port on the
Samsung switch. Refer to Chapter 1: Setting Up the Samsung DCS Key
Telephone System For CTI Link.

Be sure that the COM port has been enabled in the system’s CMOS and that no
other devices are conflicting with the IRQs used for the port. COM 1 and COM 3
use IRQ 4. COM 2 and COM 4 use IRQ 3.

Step 7. Click OK. The following Domain Admin dialog box appears:

Domain Admin

Flease enter the Mame and Password of the Domain
Administrator under whosze account, TAPI 2.1 Service is
TLANIng.

Domain Mame : I
Domain Admin Mame : I
Paszword : I

Mest » I [Carne]

Figure 2a-29

Step 8.  Enter the Domain Name of the NT Server. If the Telephony Server is a
standalone server, enter the name of the Primary domain.

If your NT System is an NT Workstation, enter the computer name of your PC into
the Domain Name field and its administrator name and password into the
corresponding fields.
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Step 9. Enter the Domain Admin Name (Administrator).
Step 10. Enter the Administrator password.

Step 11. Click Next. The following Install dialog box appears:

Do you want ta start the
DECS Telephony Service Provider
ak Server startup ?

Figure 2a-30

Step 12. Click Yes for the Samsung DCS Tapi2.1 Telephony Service Provider to
start automatically at startup.

If you select NO, the start mode is set to manual. This manual mode causes some
delay whenever you try to start any CTI application because of the initialization
time of the Telephony Service Provider.

The Setup Complete dialog box appears:

Setup Complete

Setup has finished instaling DCS Telephony Service Provider on
your cornputer,

Setup can launch the Read Me file and DCS Telephorny Service
Provider. Chooze the options pou want below.

[T Shaow me the Readme. Tt fle Maw.

¥ Start the DCS Telephony Service Provider Now.

Click Finish to complete Setup.

< Bach: I Finizh I

Figure 2a-31
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Step 13. Select Start the DCS Telephony Service Provider Now option and click
Finish. The Restart WINNT dialog box appears:

Restart WINNT

Setup has finished copying files to pour computer. Before pou can
uze the program, you must restart Windows or your computer.

Choose one of the following options and click OF to finish setup.

% Mes, | want to restart my computer novw

© No, | will restart iy computer later,

Figure 2a-32

Restart your computer before using the Samsung TSP Version 2.1 for DCS Series
for the first time, to ensure that the dongle is operating correctly.
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23.2.4

Checking the Operation of the Samsung TSP Version 2.1
for DCS Series

This chapter explains how to check the operation of the Samsung DCS Tapi 2.1
Telephony Service Provider after installing Smart Control Network V4.1 as Server
Mode.

Step 1. Open the Control Panel and double-click the “Services” icon.

Hi Profiles...
Startup Parameters:

Services
Service Statuz Startup
Flug and Play Started Autamatic ;I
Protected Storage Started Autamatic Start |
Remate Pracedure Call [RPC) Locator Started Autamatic
Femate Pracedure Call [RPC) Service Started Autamatic Stop |
:Samsung DC5 Tapi S ervice Started Autarnatic:
Server Started Automatic &I
Spoaler Started Autamatic J B |
Spstemn Event Motification I anual —
Tazk Scheduler Started Automatic S |
TCPAP NetBIOS Helper Started Automatic || ==

Help

Figure 2a-33

See if the “Samsung DCS Tapi Service” is started or not.
If this service has not been started, click the Start button.

When the Samsung TSP Version 2.1 for DCS Series is started, some initialization
procedures are carried out.The Samsung TSP Version 2.1 for DCS Series makes a
connection between the Telephony Server and the Samsung DCS Key Telephone
System. This CTI Link Initialization procedure between the Telephony Server and
the Samsung DCS Key Telephone System consists of several internal steps.

First Step. Link Check Step (the serial cable link check between the

Telephony Server and the SIM ). If the connection type is the serial
connection, this step will be skipped.
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Second Step.  The Samsung TSP Version 2.1 for DCS Series notifies the
Samsung DCS Key Telephone System that the TSP is alive and
active. If you did not set up the Samsung Key Telephone System
for the CTI Link, this step will fail. For detailed Information, refer
to Chapter 1.

Third Step. Downloading the Device List from the Samsung DCS Key
Telephone System. The Samsung TSP Version 2.1 for DCS Series
receives the device list from the Samsung DCS Key Telephone
System and manages this list as the internal information.

Fourth Step.  CTI Link Sanity Check.

The Samsung TSP Version 2.1 for DCS Series tries to check the
CTI Link Availability by sending and receiving a periodic Link
Check Command to the Samsung DCS Key Telephone System. If
there are any problems or errors at the CTI Link, the Samsung
DCS Tapi2.1 Telephony Service Provider tries to connect the CTI
Link again.

If you did not connect the dongle to the Telephony Server, the above initialization
procedure is not carried out.

For detailed information, try to follow steps.

Step2. In Windows, click Start, Programs, DCS Telephony Service Provider,
and DCS-CTI Link Monitor. If this is the first time that you have
accessed the DCS-CTI Link Monitor, the following dialog box appears:

Tapi Server |

Enter the name of the Tapi 2.1

Server Name : |

Cancel

Figure 2a-34
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Enter the Telephony Server Name.

Do not enter the Telephony Server’s Domain Name. If you enter the Domain
Name, DCS-CTI Link Monitor Program cannot monitor the CTI-LINK Message.

If you want to change the Telephony Server Name, select File / Server Name of
the DCS-CTI Link Monitor Program.

File Edit Mew Window Help

eOiz|

B 2PI-TSP Spy

WE'SMDR Monitor

Figure 2a-35
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This DCS-CTI Link Monitor Window consists of three sub-windows.

o TAPI-TSP Spy window: This is used to monitor messages between TAPI and
the Telephony Service Provider.

o DCS-CTI Link Monitor: This is used to monitor messages between the Samsung
TSP Version 2.1 for DCS Series and the Samsung DCS Key Telephone System.

¢ SMDR Monitor: This is used to monitor SMDR messages from the Samsung
DCS Key Telephone System. To monitor SMDR messages with this Monitor
Program, make sure you have correctly set the SMDR Logging option for the
Samsung Telephony Service Provider, and the SMDR options in MMC 725
of the Samsung DCS Key Telephone System.
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Step4. If you execute the CTI application Dialer.exe, you can see the message
from the DCS-CTI Link Monitor.

A P Pratocal Monitar
File Edit Vew Window Help

[e 1|

TAPI->TSP
FUNCTION=>TSPI_lineGetAddressCaps
RESULT==>SUCCESS

TAPI->TSP
FUNCTION=>TSPI_lineGetAddressCaps
RESULT==>SUCCESS

Thu Jun 10 15:11:46 19998
MSG_Seqtt = ffff
DevicelD1 = 219f
Tenant=0

Event: ONHOOK
DevicelD2 = 206f

B
1207 01/17 02:14:29 DND OFF -
1207 01717 02:14:35 DND OFF
1207 704 01717 02:14:40 00:00:00 0 200
1207 703 01/17 02:14:47 00:00:00 O 206

Feady |Connected to Server - ctizero I@

Figure 2a-36

File Edit Wiew Window Help File Edit Wiew Window Help

(=lkd]
ﬂEnabIe/DisableTracing-

The application can also be used to save each trace message.
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2a.2.5 Changing the Configuration of the Samsung TSP Version 2.1

for DCS Series

This chapter explains how to change the configuration of the Samsung TSP Version
2.1 for DCS Series and the Samsung Key Telephone System for the CTI Link.

Step 1. Stop all TAPI applications that use the Samsung DCS Tapi Service.

Step 2. Open the Control Panel and double-click the “Services” icon.

Cloze

Services
Service Status Startup
Flug and Play Started Automatic d
Protected Storage Started Autarnatic
Remate Pracedure Call [RPC) Locatar Started Autarnatic
Started Autamnatic

|Remate Procedurs Call (RPC) Service

Spaaler

Syztem Event Motification
Tazk Scheduler

TCPAP NetBIOS Helper

Startup Parameters:

Started
Started
Started

Started
Started

Automatic
Automnatic
Automnatic
I atal

Automatic
Automatic

Start:
Stop
Eauge

[Eartinue

Startup...

B I

Hif Profiles...

POk b

Help

See if the “Samsung DCS Tapi Service” is started or not. If this service has not been

Figure 2a-37

started, select “Samsung DCS Tapi Service” and click the Start button.
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Step 3. Open Control Panel and double-click the “Telephony” icon.

It takes some time to open “Telephony” and initialize the Samsung TSP Version
2.1 for DCS Series if “Samsung TSP for DCS Series” has not been started.

Dialing Properties EH

My Locations Telephony Dirivers |

The fallowing telephony drivers are installed
on this computer:

Samzung TSP for DCS Series
TAPI Kemel-tMode Service Provider
Unimodem Service Provider

LConfigure. .

Cloze [Carce| Sppli

Figure 2a-38
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Select “Samsung TSP for DCS Series” and click the Configure... button. The
Communication Settings dialog box appears.

Communication Sethings

| Cannect to DCS :

—COM Part Settings for CTI link

Com. Port IEDM1 YI ' Through St
" Using Direct Seral Connection
Baud R ate 19200 &

Dats Size

—5MDR Logaing Options
I Logto COM Port ICUM2 'l

I Logta MamedPipe : "DCSSMDRPipe"

Ig vI
Stop Bits I'I 'I

ok LCancel

About |

Figure 2a-39

For configuration details, refer to Section 2a.2.3: Installing the Samsung TSP
Version 2.1 for DCS Series.

After changing the options you want to change, click OK .

Samsung DCSTSP

@ “t'ou need to close and restart all the TAP| applications for changes to take effect.

Figure 2a-40

Click OK to continue.
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Step 4. Close the “Dialing Properties” window above.

If you restart your PC now, the remaining COM port setup procedures (step
5~step 7) will be performed automatically. Before restarting, do not forget to
change the serial cable connection to your PC to the new port.

Step 5. Open the Control Panel and double-click the “Services” icon. Verify that
the “Samsung DCS Tapi Service” is stopped.

After stopping the Samsung DCS Tapi Service, stop the “Telephony
Service”, too.

Services
Service Statuz Startup Claze
Remote Procedure Call [RPC) Service Started Automatic d
Samzung DCS Tapi Service Started Autarnatic et
Server Started Automatic
Spaaler Started Autornatic Stop
Syztem Event Motification M anual P
Tazk Scheduler Started Automnatic Lause
TCF'!IP MetBI0S Helper Started Autornatic

[Eartinue

T elephory Service Started Automatic
UpPs M anual -
Vista Telephony Dynamic Data Service Started Automatic j —

Hif Profiles...
Startup Parameters:

Help

L

Figure 2a-41

If the following error occurs at this step, ignore it.

i tapisry_exe - Application Error

The instruction at ''0:10015cfc"" referenced memaory at "0=0000002c". The memony
could naot be *read"

Click on OK to terminate the application
Click on CAMCEL to debug the application

OE. | Cancell

Figure 2a-42

Step 6. Change the serial cable connection to your PC to the new port.
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Step 7. Open Control Panel --> Services. Start the “Samsung DCS Tapi Service”.
The “Telephony Service” will be started automatically.

It takes some time for the Samsung TSP to initialize the link between the DCS
System and the Telephony Service (Device Download Procedure). If there are
many services in the DCS System, it will take 1 or 2 minutes at least.

If you encounter any problems you cannot solve while changing the Telephony
configuration, restart your PC.
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Check Points for CTI Link

This section explains how to solve any CTI Link problems if they arise. Follow
these steps.

1.

Is the dongle (hardware key), provided with the software, plugged into your
PC’s enabled parallel port?
If the dongle is unplugged or mismatched, the “Samsung DCS Tapi Service” is
unable to initialize.
If the parallel port where the dongle is plugged in is not enabled, the dongle
driver cannot run.

Did you connect the serial cable to the appropriate COM port?

Is the CTI Link type correct for your DCS system (SIM or Direct Serial
Connection)?

Did you configure COM port parameters correctly?

The default baud rate is 9600. Depending on the Samsung DCS Key Telephone
System, the baud rate can be set to another value (19200). Refer to MMC 804
(System I/O Parameter).

Check the configuration and parameters of the DCS system’s I/O settings. For

the CTI Link, the following types are supported in MMC 804.
CTL CTI/SMDR, CTI/UCD, CTI/SMDR/UCD
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MMC 804 System I/0O Parameter

Parameter Options

Dial 0  Service Type of Service

Dial1  Baud Rate Speed

Dial2  Char Length Character Length

Dial3  Parity Parity Bit

Dial4  Retry Count Number of Retries

Dial 5  Stop Bit Stop Bit

Dial6  Wait Time Message Wait Time

Service Type

Dial0  CTI CTI

Diall  CTI/SMDR CTI and SMDR
. CTI

Dial2 CTVUCD REPT UCD Report on request by the Supervisor
. CTI

Dial3  CTI/SMDR/UCD .

Both SMDR and UCD Report will be generated

Speed

Dial0 1200 bps

Dial 1 2400 bps

Dial2 4800 bps

Dial 3 9600 bps Default

Dial4 19200 bps

Character Length

Dial 7 7 bits

Dial 8 8 bits Default

Parity

Dial0  None Default

Diall  Odd

Dial2  Even

Stop Bit

Dial 1 1 bit Default

Dial2  2bit
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20.2.6

TAPI Client Manager

TAPI 2.1 introduces the TAPI Client Manager(tcmapp.exe), a basic administrative
tool that makes it easier and less expensive to manage and configure client-server
telephony applications. The Client Manager standardizes telephony management,
and provides an easy way of associating a user’s telephone number with the user’s
account name on the Windows. If you want to use your telephony line through your
Smart Control Network V4.1 at any client Machine, you have to set this TAPI
Client Manager.

Using the TAPI Client Manager

‘When using this tool, you must be logged on to the Windows NT Server machine
(Telephony Server) as an administrator account. You add user accounts to the
Telephony Server, then give them access to the appropriate lines. You may add
users from any Windows NT Server domain. For any given user account, you may
grant access to as many lines as needed.

Click Start, Run, and enter tcmapp.exe
Adding User Accounts to the Telephony Server
o Click User, and then click Add a User to this Telephony Server...

I TAPI Administration Application H=
File QIECM Line Help

Add a Uszer to thiz Telephony Server...
Bemove the Selected Llser

Lhange Selected User's Line Access...

EBroperties
TPy
i wpdelka
e wpecho

Figure 2a43
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To bring up the following dialog box:

Add Users and Groups
List Mames From: I S CTITEAM® j
Mamesz:
Diomain Adrninz Desighated adminiztiators of the domair: &
Domain Guests Al domnain guests
Domain Users All domain users
ﬁ Adrministrator Built-in account for administering the cor
ﬁ clione [cione] clione
€ eslee (Lee En Sil) Lee's PC
ﬁ Guest Built-in account for quest access to the
ﬁ hhkim [Kim Ha Hong) Kirn's PC ha
Ldd Idemtaers. Search... |
Add Hames:
[~
| -
ak. I Cancel Help
Figure 2a-44

Click a user account entry, then click Add. This puts the user account Domain name
and user account name into the Add Names area. If you have more than one user to
add to the Telephony Server, you may do this as many times as necessary without
leaving this dialog box. When finished, click OK.

See the following section for information on how to specify which lines a user
account may access.

Enabling a User Account to Access Telephony Devices on the
Telephony Server

In order to give a user access to one or more telephony devices, the user account
must have already been added to the Telephony Server. See the previous section for
information on how to do this.

To change the lines that an existing user can access, first locate the user account in
the correct Windows NT Server domain in the main window. Next, position the
pointer over the user account name and right-click. This will bring up the following
menu:
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I TAPI Administration Application
File User Line Help
= CTITEAM

[ Aadminiztratar

Remove Selected User
- Ty

- wpbr  Change Selected User's Line Access
- wpch
- wpde Properties

-- vpecho

Figure 2a-45

Click Change Selected User’s Line Access. This will bring up a dialog box filled
with the telephony devices available on this Telephony Server. If the selected user
account already has access to one or more lines, those devices will be highlighted:

Change Line Device Access For Selected User

The TAPI line devices that the user curently has access ta are highlighted.
To add additional lines. hold down the <Chil> key and click on the line to add.
Toremove lines, hold down the <Chil: key and click on the line to remove.
Lire M ame Switch [nfo Provider Info Permn Line D~
I =
DCS Line 202 Samsung DCS Gamsung DS Service Provider 1202
DCS Line 203 Samsung DCS Samsung DCS Service Provider 1203
DCS Line 204 Samsung DCS Samsung DCS Service Provider 1204
DCS Line 205 Samsung DCS Samzsung DCS Service Provider 1205
DCS Line 206 Samsung DCS Samsung DCS Service Provider 1206
DCS Line 207 Samsung DCS Samsung DCS Service Provider 1207
DCS Line 208 Samsung DCS Samzsung DCS Service Provider 1208
DCS Line 209 Samsung DCS Samsung DCS Service Provider 1209
DCS Line 210 Samsung DCS Samsung DCS Service Provider 1210
DCS Line 211 Samsung DCS Samzsung DCS Service Provider 1211
Difﬂ Line M2 Samaunn DCS Samzunn NS Service Provider 1212 | _l;l
4 3
|
Figure 2a-46
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Click the lines to which this user account should have access. You may select more

than one line:

« To select a sequential range of lines, click the line that is first in the range. Then
locate the last line. Then, while holding down the Shift key, click the line that is
last in the range. This will cause all lines from the first to the last to be selected.

o To select more than one line that are not sequential, hold down the Control key
and click each line that the user should have access to.

[ TAPI Administration Application M= =
File User Line Help
= ETITEAM

B

DCS Line 201 Samsung DCS Samsung DCS Service Provider
DCS Line 209 Samsung DCS Samsung DCS Service Provider
DCS Line 210 Samsung DCS Samsung DCS Service Pravider
DCS Line 211 Samsung DCS Samsung DCS Service Provider
- DCS Line 212 Samsung DCS Samsung DCS Service Pravider

¢ L~ DCS Line 202 Samzung DCS Samsung DCS Service Provider
EI wpbrabo
L. DCS Line 203 Samzung DCS Samzung DCS Service Provider
pchally
¢ L~ DCS Line 204 Samzung DCS Samsung DCS Service Provider
] wpdelta
DCS Line 205 Samaung DCS Samsung DCS Service Pravider
- wpecho
. DCS Line 206 Samzung DCS Samzung DCS Service Provider

Figure 2a-47

When finished, click OK. The main window will be updated to show the updated
list of lines to which the user currently has access.

Changing the Order of Telephony Devices for a User Account

You might want to have a user’s lines viewable in a specific order. For example, an
organization might use a third-party TAPI program that manages calls using the first
available line. If an assistant must answer the supervisor’s phone as well as his own,
it might be preferable for the assistant’s line to be listed before the supervisor’s line.
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To move a particular line up or down in the order of lines for a user, position the
pointer over the line to be moved and right-click. This will bring up the following

menu:

I TAPI Administration Application
File User Line Help

= CTITEAM

£l Administrator
DCS Line 201 Samsung DCS Samsung DCS Service Provider
DCS Line 209 Samsung DCS Samsung DCS Service Provider

Femove Selected Line

& up in order

Mowe the selected line down in order

Properties

- DCS Line 203 Samsung DCS Samsung DCS Service Pravider

pchally

- DCS Line 204 Samsung DCS Samsung DCS Service Pravider

|- wpdelta

DCS Line 205 Samsung DCS Samsung DCS Service Pravider

- vpecha
i DCS Line 206 Samsung DCS Samsung DS Service Provider

Figure 2a-48

Clicking Move the selected line up in order will move the selected line up one
place in order to be positioned over the line that is immediately above it. If the
selected line is already the first in the list of lines for this user, this menu item will be
unavailable (appears dimmed).

Clicking Move the selected line down in order will move the selected line down
one place in order to be positioned under the line that is immediately below it. If the
selected line is already the last in the list of lines for this user, this menu item will be
unavailable (appears dimmed).
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2a.3 Troubleshooting

If you have problems running Smart Control Network V4.1, look through the
problem checklist below.

Symptom or Error Message Resolution

e s o Smart Control receives a error code during
TAPI can not be initialized,

. calling the line Initialize function
Please try after some time

i o Check the Telephony Client Configuration

TAPI has not been setup

. e Smart Control receives a error code during
properly in your system, Please

calling the line Initialize function

configure TAPI and run | ) ]

SmartControl i o Check the Telephony Client Configuration
''''''''''''''''''''''''' " e You did not have any assigned line from

No lines have been assigned to telephony server

you!! e Request some assigned lines to your

i Telephony Server Administrator

S e You did not configure the Telephony Client

Fail to open the line Configuration.

i & Run tcmsetup.exe and refer its help file.

____________________________________ e
1

o Check your telephony dialing parameters

Unable to make Outgoing Calls
from the Control Panel

Table 2-1
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2b. Installing Smart Control Network

For DCS Gateway

2b.1 System Requirements

2h.1.1

Samsung Smart Control Network V4.1 software have two installation options. One
is the Server Installation mode and the other is the Client installation mode. When
you select the Server Installation, Smart Control Network V4.1 Install wizard will
try to install two packages on your system. In case of the Client Installation Mode, it
will try to install only Client Software. According to each installation mode, System
requirement is different. See the below.

Computer Hardware & Operating System & Switch System

To Install Smart Control Network V4.1 as the Server Installation Mode. (at
Telephony Server)

o Computer System : Windows NT Server 4.0 - Service Pack 4 or later and This
NT system must belong to a domain or have Primary Domain Controller.

« Make a connection between NT Server and Samsung DCS Gateway System
with IP-Address (Samsung DCS Gateway System’s ip address) and Port-no
(2100)

« Log on as administrator of NT Server System
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To install Smart Control Network V4.1 as the Client Installation Mode. (at
Telephony Client)

o Computer System : Windows NT Server / Workstation 4. 0 — Service Pack 4 or
later, Windows 95 / 98
—must run the “Client for Microsoft Networks”,
—have “User-level access control” enabled,
— have “File and printer sharing for Microsoft Networks” enabled.
— Refer to the Windows 95 / 98 help file for details on how to enable
these features.

« FEach Client Users: must be logged on using a valid domain account to
Telephony Server.
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2b.2 How to Install

2h.2.1

Installing on Windows NT Server as the Server Installation Mode

Presetting the NT Server System to install the Smart Control Network V4.1

Please verify that your Samsung DCS Gateway System is operating on current
firmware. You may want to contact your Samsung Representative to determine
whether the firmware you are using must be updated.

CONFIGURING TAPI 2.1 as Telephony Server

This chapter explains the procedure for Tapi 2.1 configuration on the Telephony
Server. If you use a Microsoft Windows NT Workstation as the Telephony Server,
you need not read this chapter.

« Configuring the Telephony Server

1. Select Run from the Start menu on the Telephony Server.

Run HE

Tupe the name of a program, folder, or document, and
Windaws will open it for you.

=

[V | Bt Separate Memon Space

QK. I Cancel | Browse. .. |

Figure 2b-1
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2. Type temsetup and click OK. The following help screen appears:

Telephony Server/Client Setup Help E
Uszage is:

SERVER SETUR
TCMSETUP [#Q] /5 [/M] domaintusername [password] [managamentdlist]

domainhuzername is the full domain ahd usemanne of administrative TAP] account
paszzword is the password for that account

managementdlllizt iz the optional list of DLLs. The DLL names are delimited with double quotes (]
A - will cauze meszage boxes to not be displayed during setup
/M indicates the username does not have a password. |n this case, the password parameter iz not needed.
SERVER DISABLE
TCMSETUR [/Q3] /5 /D
CLIEMT SETUF
TCMSETUR [AQ] [#] /C remoteservername
remoteservernanme is the machine name of the telephony server
A - will cauze message boxes to not be displayed during setup
M- connectionless callbacks. glower but more efficient
CLIEMT DISAELE
TCMSETUP [/Q] /C /D

Figure 2b-2
You can see the options that can be used with TCMSETUP on the screen.

3. Click Start and Run and type
TCMSETUP /S domain‘\username password.

If the Telephony Server is a PDC, domain represents the domain name. If the
Telephony Server is a standalone server, domain represents the computer name
of the Telephony Server.

Username is an NT user account with Administration Privileges.

Password is the password of the NT User account.
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If the setup is successful, the following dialog box will appear:

TAPI Administration Setup

TAP| Server successfully set up.

Figure 2b-3

Click OK.

2b.2.2  Installing on Windows 95/98/NT as the Client Installation Mode

Presetting the Client System to install the Smart Control Network V4.1

CONFIGURING TAPI 2.1 as Client
o Configuring the Telephony Client

1. Select Run from the Start menu on the Telephony Server or Telephony Client.
Run

Type the name of a program, folder, or document, and
windows will oper it for pou.

=

I¥ | it Separate fdemen Space

ok I Cancel | Browsze... |

Figure 2b-4

Telephony Client System can be the Microsoft Windows NT Server, Workstation,
Windows 98 and Windows 95. In additonally, Telephony Client System have to be
logged on to the Telephony Server as NT Server’s User. For detailed information
about Tapi 2.1 configuration, refer to the Microsoft Web Site.
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2. Type TCMSETUP and click OK. The following help screen appears:
]

Usage is:
CLIEMT SETU%
TCMSETUR [M] [[%] M'C remoteservername [remokteservernamez ... ]
remoteservername is the machine name of the telephony server
12 - will cause message boxes to nok be displayed during setup
1% - connection-oriented callbacks {default is connectionless), For lossy netwarks
CLIEMT DISAELE

TCMSETUR [fQ] /C /D

Figure 2b-5

3. Click Start and Run and type
TCMSETUP /C remoteservername where remoteservername is the computer
name of the Telephony Server. An example is shown below:

run 2

Twpe the name of a program, Folder, document, ar
Internet resource, and Windows will open it For yau.

Opent I temsetup o chiserver j

Ok I Cancel | Browse. .. |

Figure 2b-6

Click OK.

On NT Workstation Clients you must be logged in locally on the NT workstation
as an administrator for TCMSETUP to work.
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4. The TAPI Administration Setup dialog box should appear indicating that the
TAPI Client was successfully installed.

TAPI Administratiol x|

TAPIL Client successfully set up,

Figure 2b-7

Presetting for Server and Client Installation Mode is now completed.

Installing Smart Control Network V4.1 on each System

« Log on you system as administrator or Domain User
- Install on Windows NT Server as Server Mode : Log on administrator
- Install on Windows NT Server/Workstation as Client Mode: Log on

administrator

- Windows 95/98 as Client Mode : Log on Domain User.

o Insert Smart Control Network V4.1 Install CD. Setup.exe will be run
automatically.

« Ifnot, Run E:\Setup.exe (where E: is the CDROM drive)

Follow the instructions in the Setup program. These instructions are described
below.
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Click the Next button in the Welcome dialogue box to continue Setup or the
Cancel button to exit Setup.

—_

Note for Windows 95 Users: If you do not have Microsoft TAPI 2.1 installed
on your system, you will be given the option to install TAPI 2.1 before
installing Smart Control Network V4.1. Select Yes to install TAPI 2.1 and
proceed with Smart Control Network V4.1 installation. If you select No, Smart
Control Network V4.1 Installation will be aborted.

Question \ [ <]

Microgoft TAPI 2.7 for Windows 35 should be installed befare Smart Contral Metwark. can be installed on your computer.
Do pou want the Smart Control Netwark Setup ta run TAPL 2.1 setup for you?

Figure 2b-8

Welcome to the Smart Contral S etup program.  This
program will install Smart Control on your computer.

Itiz strongly recommended that vou exit all windows programs
befare running this Setup program.

Click Cancel to quit Setup and then cloze any programs you
hawe running. Click Mewt to continue with the Setup program.

WARMIMG: This program is protected by copyright law and
international treaties.

Unauthonzed reproduction or distribution of thiz program, or any
partion of it, may result in zevere civil and criminal penalties, and
will be prosecuted to the maximum extent pozzible under law.

Cancel |

Figure 2b-9
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2. Read carefully the Software License Agreement (Figure 2b-11). After reading
the Software License and if you accept all the terms of it, click Yes Button.

Software License Agreement

Flease read the following Licenze Agreement. Press the PAGE DOWH key to see
the rest of the agreement.

For Srnart Control

Foftvare License Soresment & Limited ' aranty ﬂ
Samsung Electronics Co., LTD.

IMPORTAMT, READ CAREFULLY :

Thiz Samzung End-User Licenze Agreement [ELULA) iz a legal binding agreement

betweeh you (either an individual or an entity] and Samzung for 5 amsung software

product identified above, which includes computer software and may include printed

material, and "onling” or electronic documentation ["SOFTWARE"). By instaling. using

the SOFTwARE , pou indicate your acceptance of thiz Samsung License dgreement. |f

vou do hot agree to the terms of this License Agreement, please do not install or use the
enclozed SOFTWARE. ﬂ

Do you accept all the terms of the preceding License Agreement?-Jf you choose No, Setup
will cloze. To install Smart Control Metwork., you must accept this #5reement.

< Back Yes Mo |

Figure 2b-10

3. Next, You can see the next Dialog Box. Select the install mode you want.

Select a Smart Control Hetwork

Setup can install the Smart Control Metwaork for Server or Client.
Chonse the optionz listed below which vou would like to install.

1 Smart Control Metwork, for Server

" Smart Control Network for Client

< Back I Mest » I Cancel

Figure 2b-11
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4. You can see the User Information Dialog Box. Enter name and company.
Click the Next Button.

t Information x|

Pleaze enter pour name and the name of the company for whom
pou work,

Mamne: IETI

LCompany: |Samsung Electronics Co., Ltd)

< Back I Mext > I Cancel

Figure 2b-12

5. Choose the destination directory where Smart Control Network V4.1 will be
installed.

Chooze Destination Location (%]

Setup will install Smart Contral Metwork, in the following falder.
Ta install ko this folder, click Mext.

Ta install ko a different folder, click Browse and select anather
falder.

‘You can chooze not to install Smart Control Metwork by clicking
Cancel to exit Setup.

" Destination Folder

C:A.. vSmart Contral Mebwark Browse. . |

< Back Cancel |

Figure 2b-13
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6. The following dialogue box appears. Click Next after entering the program
folder name.

Select Program Folder (%]

Setup will add program icons to the Program Faolder listed below.
‘Y'ou may type a new folder name, or select ane from the existing
Folders list. Click Mest to continue.

Program Folders:

Ezisting Folders:

liveCaster -
MGA NT PowerDesk _I

Microzoft Reference
Microzoft Visual Studio 6.0 J

MetShow Services
Morton Antirus
Phonetd ax

Smart Control

Snart Control Mebwork

< Back I Mest » I Cancel

Figure 2b-14

If you try to install the Smart Control Network without uninstalling the previous
version, you will see the following dialog box.

Question

@ Do you want to ovenwrite wour Directory and Call Log database files?

Figure 2b-15

Select Yes or No. If you select Yes, your previous Contact Database file is
deleted and the new empty database file is overwitten.
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Files are copied to your selected directory and the ODBC is configured. The
following dialogue box appears. Click Next button.

Information [ x|

Setup haz copied the files successfully.

MNow you can configure zome of the application and the
telephony diiver parameters. [If you have selected that
component.]

Figure 2b-16

7. The following Call Notification Options dialogue box appears. Enter your
options. While using Smart Control Network V4.1 you can change the call
notification options by selecting the Call Notification... item on the Option
menu.

Call Hotification Ophions

Flease zelect the Smart Control Call Hohfication Options.

— Dizplay Call Detailz:

™ Far Incoming Internal Calls
™ For Outgoing Calls

— On Incoming Call
r Bring Smart Contral ko Front
™ Play sound for Incoming Call

I Browse |

Figure 2b-17
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Then, select the language which you want your resources in.

You can change the language anytime after you finish setup, using “SCN Language

Selection.exe”. This program is newly added Smart Control V4.1 International

Package.

Be sure that the Smart Control is not running when you try to launch SCN Language

Selection.exe.

rt Cantrol 1 International = |

What language would vou like your resources in?

|Mone Selected |

Cancel |

Figure 2b-18

8. Change the dialing properties, if needed. The dialogue box below shows the

properties.

Dialing Properties

My Locations I Telephany Drivers I

EHE

| am dialing frana:

Mew... | Eemovel

| am in this country/region: Area code:

IKorea [Republic af] j |2 Area Eode Hules. |

—'when dialing from here

To access an outzide line:

For local calls, dial I

Far long distance calls, dial Ia

[~ Todisable call waiting, dial: | v|

Dial using: & Tone dial ¢ Pulse dial

™ Far long distance callz, use this calling card:

|Narne [Direct Dil] =] Calling Card... |

ak I Cancel Apply

Figure 2b-19
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9.  When you click the OK button on the above dialogue box, one of the next two
types dialogue box appears confirming that Smart Control Network V4.1 has
been installed successfully.

Case 1 : Server Mode Installation

Setup Complete

Smart Contral Metwoark %4.1 Setup has completed.
Select a telephony zervice provider.

™ i would like ta install the DCS R

V' | would ke toinstall the DCS -Gateway TSP,

Click Finish to complete Smart Contral Metwark Setup.

< Back I Finish I

Figure 2b-20

Case 2 : Client Mode Installation

Setup Complete

Srart Control Metwork. %4.1 Setup has completed
Choose the options you want below

™ i would like ta view the README file.:

™ Launch Smart Eon%l Metwork 4.1 Mow

Click Finish to complete Smart Contral Metwork Setup.

< Back I Firizh I

Figure 2b-21

2b-14




2b. Installing Smart Control Network For DCS Gateway

When you try to install Smart Control Network V4.1 as Client Installation Mode,
Installation is completed at this step. How ever, If you try to install as Server
Installation Mode, Install Shield will go on next step : Samsung TSP 1.0 Installation
Step.

Click Finish button to complete the Setup.

The following Step is only for Server Mode Installation.
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2h.2.3 Installing the Samsung TSP Version 1.0 for DCS Gateway

You must install the Samsung TSP (Telephony Service Provider) for handling the
events to / from the Samsung DCS Gateway System. The service name displayed in
the Control Panel->Services window is Samsung DCS Gateway Tapi Service.

Follow the instructions in the Setup program. These instructions are described
below.

If you do not have Microsoft TAPI 2.1 Service installed on your NT system, you
should install and start this service before installing the Samsung TSP.

Important Notice | X |

-"i\ Pleaze make sure that TAPI 2.1 Server iz installed on this syzten before
ingtaling TSP. Othensize Samzung TSP will not function properly.

Figure 2b-22
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Step 1. Click the Next button in the Welcome dialogue box to continue.

Welcome

Welcome to the Samsung TSP Setup program. Thig
program will install Samzung TSP on your computer.

It iz gtrongly recommended that you exit all windows programs
before running thiz Setup program.

Click Cancel to quit Setup and then cloge any programs you
hawe running. Click Hest to continue with the Setup program.

WARMIMG: Thiz program iz pratected by copyright law and
international treaties.

Unautharized reproduction or distribution of this program, or aty
portion of it, may result in gevere civil and criminal penalties, and
will be prozecuted to the maximum extent pozsible under law.

Cancel |

Figure 2b-23

Step 2. Choose the destination directory where the Samsung TSP will be installed.

tination

Setup will install Samsung TSP in the following Folder.
Ta install to this folder, click Mest.

To inztall to a different folder, click Browse and select anaother
folder.

‘fou can choose not to install Samsung TSP by clicking Cancel
to exit Setup.

" Drestination Folder

E:\. ASamsung TSP Browse. .. |

< Back MNewt> Cancel |

Figure 2b-24
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Step 3. The following dialog box appears. Click Next after entering the program
folder name.

Setup will add program icons to the Program Folder listed below.
'ou may type a new folder name, or select one from the existing
Folders list. Click Mext to continue.

Program Folders:

E zisting Folders:

Creative

Dialogic System Software
MGANT PowerDesk
Ficrozaft

Seagate Crystal Reparts
Smart Contral Network,
Smart Dperator

WinZip

< Back I Mext > I Cancel

Figure 2b-25

Step 4. Files are copied to your selected directory. The following dialog box
appears. Click Next button.

arnplete

Setup has finished copying files to pour system
Mow you can configure Lan or Com Port interface

for Samzung TSP

Click. Mext button to proceed with configuration

Figure 2b-26
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Step 5. Set the COM port for your computer. Choose LAN from the Connection
option and enter the DCS Gateway’s IP address into IP Address field of
the Set LAN option. You can set the LAN Protocol to be “Flexible” or
“Fixed” (Default Value: “Flexible”).

Communication Port Settings
— Connection
= Lan € Comm
—Set Lan
IP Address  [166.219.63.250 | | -an Fretecel
' Flexible
Port M 2100
o C Fixed
— Set Azpnc.

(e Bt T Lirk Pratazol

I jv
Hiand|Biste I 'I ) ENELACK
I jv

[Wata Size

00 BRI ATR 2
Stop Eits I LI
Cancel I About
Figure 2b-27

Please confirm with MAP Utility.

DATABASE MANAGEMENT => SYSTEM DB MANAGEMENT | => IPM
Information.

InfoLink Version : Fixed Format (~V330) or Flexible Format (V340~)
(Default Value : Flexible Format (V340~)

Lan Protocal and InfoLink Version should be set as the same value.
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Step 6.

Step 7.

If your computer system is a Primary Domain Controller, enter your PC’s
domain name, domain administrator name, and domain administrator’s
password. If not, enter the computer name of your PC into the Domain
Name field, and its administrator name and password into the
corresponding fields.

Ll:lgil'l E
Damain Mame : Ictione
Admin Mame Iadministrator
Password : |x>1
Figure 2b-28

If you want to start the Samsung TSP at server start up, click Yes.
Otherwise click No.

Do guu want to start Samsung TSP
at Server startup?

The dongle provided with the Smart Control software must be connected to a
parallel port of the computer before the Samsung TSP is running. Verify that the
parallel port is enabled. The Samsung TSP queries the port at startup and at
programmed intervals thereafter. If the Samsung TSP does not detect the dongle’s
programmed validation code, it repeatedly tries dongle’s detection until it receives
the valid response.
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Step 8. Mark your options and then, click on Finish.

Setup Carmplete

Setup has finizhed installing S amsung TSP and related
components o your Computer.

Setup can Launch Read ke file and
Samzung Device management Tool uzing which you can
generate the Device Database for Samszung TSP

W Show me the Feadme. bt file Mo

¥ Launch The SDMT.

It iz recomended that you launch the SOMT now and add the
Devices which are uzed for creating Line Devices by
Samszung TSP

< Back I Finizh I

Figure 2b-30

Step 9.  Set the SDMT and then restart Windows NT.

Important Motce

@ After setting the SOMT, restart Windows MT,

Figure 2b-31

Step 10.  Adding devices.
The Samsung Device Management Tool (hereafter referred to as SDMT)
utility is used to setup the DCS Gateway device database containing
extension numbers and their related information.

The Samsung TSP setup is done.
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How to Launch Samsung Device Management Tool

The Samsung Device Management Tool (hereafter referred to as SDMT) utility is
used to setup the DCS Gateway device database containing the extension numbers
and their related information.

Before using SDMT, you must setup the MAP on the DCS Gateway. For details,
refer to the MAP user manual or refer to the CTI link check points found in FAQ’s.

When you run the SDMT utility the main screen is displayed as shown below.

% Samsung Device Management Tool

Fle Edit ‘iew Help
H=n 7
Estenzsion Mo, Extension Type User ACD Agent o
WWWM“
2002 Station
@ 3 2100 Station NU
End 200 Station Mo
ol 401 Trunk: Mo
GG 402 Trunk: No
7 403 Trunk Mo
@ a 461 Trunk Mo
&g 462 Trunk: Mo
&1 463 Trunk. Mo
11 2500 Station Mo
&z 1000 Station No
Bz 1004 Station Mo
G4 1005 Station Mo
P TRk 1003 Statior No
e
&7
&ne =l
Ready. Nurber of deviees =15 2

Figure 2b-32

It shows the DCS Gateway devices added in the form of a list. The list contains the
following columns:

¢ NO shows the serial number of the DCS Gateway extensions from 1 to 512.
These serial numbers are fixed and are used by the Samsung TSP to create line
names. The line names appear in the TCMAPP application for the purpose of
line allocation.

« Extension No. Shows the extension number of the device added by the user.

« Extension Type shows the type of the device.
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« User shows the name of the user of the device.
o ACD Agent shows whether the extension allocated is an ACD agent.

The status bar shows the total number of devices currently in the database.

File Menu

This menu has the following menu items.

Save — Saves the current extension list.
Exit — Exits from the application.

Edit Menu

1. Add - Add an extension or a set of extensions whose numbers are consecutive.
The dialog boxes are displayed below when this menu item is selected.
When adding a single extension:

& Add 4 Single Extension

MO, ; I‘I 5
Estension Mumber : i1

User : Kin{
Esténsion Type ¢ m
ACDAgent = [

" Add A Set O Extensions

StartmmEran ME I'I ;
BRI A= R Ll I
[mGer [ ERensiE |[|
Ertermnnlype m
ATl brEts -
o | Cancel |
Figure 2b-33
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« Extension Number — Extension number of the device to be added.

o User — The name of the user of this extension. This field is optional. (Optional)

« Extension Type — Currently only one type of extension is available, ACD.

¢ ACD Agent — If marked this extension is to be designated as an ACD Agent.
(Optional)

When adding a group of extensions:

Add Extension[s]

7 Add A Single Extension

(o Add s Set Of Extensions

Starting From MO, l'IB—
From Extenzion Mo ¢ ﬁ—
Munber OF Extensions - ID—
Estension Type | m

ACD Agents o |

i Caricel |

Figure 2b-34

« Starting From NO — The serial number from where the devices are to be added.
This number should be in the range of 1 to 512.

« From Extension No — The first extension number of the group of devices to be
added.

« Number of Extensions — The number of extensions that are to be added to the
device database.

o ACD Agents — If marked all the extensions in this group are designated as ACD
agents.
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Modify — Modify an existing extension’s details.

The dialog box is displayed when the user selects the modify option. The user
can modify the extension details. The user can also access this dialog box by
selecting an extension in the list displayed as part of the main screen and double
clicking the left mouse button or by pressing the ‘RETURN’ key.

Modify Extenzion Details
. ; [
Extension Mumber 2000
Lzer = Kirm
Entension Type | Station -rI
ACD Agent : r
| Cancel |
Figure 2b-35

Delete — Delete an extension from the list.

The user can select the extension(s) in the main screen list and select this menu
item to delete the selected extension(s). The user will be prompted for
confirmation before deleting the selected extension(s).

Find — Find an extension by number or user.

This option allows a search for an extension by extension number or by user
name. The extension matching the search string is highlighted in the main
screen list.

View Menu

This menu contains menu items Toolbar and Status bar. This allows the user to

either show or hide the Toolbar and the Status bar respectively.

Help Menu

This menu contains only the About menu item and when this option is selected the

About dialog box is displayed.

Limitations

This version does not use ‘ACD Agent’ filed.
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2b.2.4  Checking the Operation of the Samsung TSP Version 1.0

for DCS Gateway

This chapter explains how to check the operation of the Samsung Inforex Tapi 2.1
Telephony Service Provider after installing Smart Control Network V4.1 as Server

Mode.

Step 1. Open the Control Panel and double-click the “Services” icon.

Services
Service Status Startup
Frotected Storage Started Automatic
Remote Access Autadial Manager Started Autornatic e |
Remote Access Connection Manager Started b anual
Remote Access Server Automatic Stop |
Remate Procedure Call [RPC) Locatar Started Autornatic =
Femote Procedure Call [RPC) Service Started Autornatic L‘
Samsung Inforex Tapi Service Started Autornatic J e |
SAF Agert Started Automatic —
Server Started Automatic Startup |
Spooler Started Autornatic 7] ===
Hw Profiles... |
Startup Parameters;
| Help |
Figure 2b-36

See if the “Samsung Inforex Tapi Service” is started or not.
If this service has not been started, click the Start button.

For detailed information, try to follow steps.
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Step2. In Windows, click Start, Programs, DCS Telephony Service Provider,

and DCS-CTI Link Monitor. If this is the first time that you have
accessed the DCS-CTI Link Monitor, the following dialog box appears:

Tapi Server l

Enter the name of the Tapi 2.1

Server Mame ©

Cancel

Figure 2b-37

Enter the Telephony Server Name.

Step 3. The DCS-CTI Link Monitor Window appears:

}} Samsung TSP - Protocol Monitor - [Protocol Analyser] [_[O[=]
File Edit “iew ‘Window Help =
SMEEEEEEE)
| -
[
Ready 7
Figure 2b-38
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This DCS-CTI Link Monitor Window consists of the following sub-window.

« DCS-CTI Link Monitor: This is used to monitor messages between the Samsung
TSP Version 1.0 for DCS Gateway System

Step4. If you execute the CTI application Dialer.exe, you can see the message
from the DCS-CTI Link Monitor.

p'-tp- Samsung T5P - Protocol Monitor

File Edt View Window Help

Dj(E| &[=e 82]

Command Type = MAKE CALL
Reserved = 0
RequestlD = 500

Ready

g‘ Protocol Analyser

Calling Device = 20 D0ffFeHfEFHEFOEFFEAE
Called Device = 200 AR

Event Type = RESPONSE

Reserved = ff

Response Device = 20001
RequestiD = 500

Response Result=1 - RESULT_POSITIVE

Event Type = SERYICE INITIATED

Reserved = {f

Initiated Device = 2000t
ConnectionlD From Initiated Device = 0
Initiated Device Type = 1 - TYPE_EXTENSION
Reservel =1

Initiated DeviceTypeld = ffif

Reserve? = ffff

Event Type = DELIVERED

Reserved = ff

Alerting Device = 200 AHHFHEETEE
ConnectionlD FromalertingDevice = 400
Alerting Device Type = 1 - TYPE EXTENSION

B

Figure 2b-39

The application can also be used to save each trace message.
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2h.2.5 Changing the Configuration of the Samsung TSP Version 1.0
for DCS Gateway

This chapter explains how to change the configuration of the Samsung TSP Version
1.0 for DCS Gateway and the Samsung Key Telephone System for the CTI Link.

Step 1. Stop all TAPI applications that use the Samsung Inforex Tapi Service.

Step 2. Open the Control Panel and double-click the “Services” icon.

Services
Sermvice Status Startup
Pratected Storage Started Autornatic
Femote Access: Autodial Manager Started Automatic St |
Femate &ccess Connection Manager Started b anual
Remote Access Server Automatic Stop |
Femote Procedure Call [RPC) Locator Started Automnatic =
Remoate Procedure Call [RPC) Service Started Autornatic L‘
S amzung Infores Tapi Service Started Autornatic J e |
SAP Agent Started Autornatic —
Server Started Automatic S |
5 pooler Started Automatic LI —
Hw Profiles... |
Startup Parameaters:
| Help |

Figure 2b-40

See if the “Samsung Inforex Tapi Service” is started or not. If this service has not
been started, select “Samsung Inforex Tapi Service” and click the Start button.
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Step 3. Open Control Panel and double-click the “Telephony” icon.

It takes some time to open “Telephony” and initialize the Samsung TSP Version
1.0 for DCS Gateway if “Samsung TSP for DCS Gateway” has not been started.

Dialing Properties [ 7]
My Locations  Telephany Drivers |

The following telephony drivers are ingtalled
on this computer;

MELIng
-5 amsung [nfares TSP

T&P! Kemneltode Service Provider
Urimadem Service Provider

DCSIP Telephory Service Provider 2.0

Sa

Add... Remove | Configure. .. I

Ok, I Caneel Al

Figure 2b-41
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Select “Samsung Inforex TSP” and click the Configure... button. The
Communication Settings dialog box appears.

Communication Port Settings

Figure 2b-42

For configuration details, refer to Section 2b.2.3: Installing the Samsung TSP
Version 1.0 for DCS Gateway.

Click OK to continue.
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Step 4. Close the “Dialing Properties” window above.

Step 5. Open the Control Panel and double-click the “Services” icon. Verify that the
“Samsung Inforex Tapi Service” is stopped.

After stopping the Samsung Inforex Tapi Service, stop the “Telephony
Service”, too.

Services

Service Status Startup

Samsung Infarex Tapi Service Started Autornatic _;I
SAP Agent Started Autamatic Start
Server Started Automatic
Spoaler Started Autamatic Stop
Syztem Event Motification Manual
Tazk Scheduler Started Automatic iz

Cloge

TCPAP MetBl05 Helper Started Automatic e
e Started Automatic J —

LIPS fd arual e

“ista Telephony Dynamic Data Service Started Autamatic L! i

Hiw Prafiles...
Startup Parameters:

I Help

L |

Figure 2b-43

Step 6. Open Control Panel --> Services. Start the “Samsung Inforex Tapi Service”.
The “Telephony Service” will be started automatically.
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2h.2.6

TAPI Client Manager

TAPI 2.1 introduces the TAPI Client Manager(tcmapp.exe), a basic administrative
tool that makes it easier and less expensive to manage and configure client-server
telephony applications. The Client Manager standardizes telephony management,
and provides an easy way of associating a user’s telephone number with the user’s
account name on the Windows. If you want to use your telephony line through your
Smart Control Network V4.1 at any client Machine, you have to set this TAPI
Client Manager.

Using the TAPI Client Manager

‘When using this tool, you must be logged on to the Windows NT Server machine
(Telephony Server) as an administrator account. You add user accounts to the
Telephony Server, then give them access to the appropriate lines. You may add
users from any Windows NT Server domain. For any given user account, you may
grant access to as many lines as needed.

Click Start, Run, and enter tcmapp.exe
Adding User Accounts to the Telephony Server
o Click User, and then click Add a User to this Telephony Server...

I TAPI Administration Application H=
File QIECM Line Help

Add a Uszer to thiz Telephony Server...
Bemove the Selected Llser

Lhange Selected User's Line Access...

EBroperties
TPy
i wpdelka
e wpecho

Figure 2b-44
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To bring up the following dialog box:

Add Users and Groups
List Mames From: I S CTITEAM® j
Mamesz:
Diomain Adrninz Desighated adminiztiators of the domair: &
Domain Guests Al domnain guests
Domain Users All domain users
ﬁ Adrministrator Built-in account for administering the cor
ﬁ clione [cione] clione
€ eslee (Lee En Sil) Lee's PC
ﬁ Guest Built-in account for quest access to the
ﬁ hhkim [Kim Ha Hong) Kirn's PC ha
Ldd Idemtaers. Search... |
Add Hames:
[~
| -
ak. I Cancel Help
Figure 2b-45

Click a user account entry, then click Add. This puts the user account Domain name
and user account name into the Add Names area. If you have more than one user to
add to the Telephony Server, you may do this as many times as necessary without
leaving this dialog box. When finished, click OK.

See the following section for information on how to specify which lines a user
account may access.

Enabling a User Account to Access Telephony Devices on the
Telephony Server

In order to give a user access to one or more telephony devices, the user account
must have already been added to the Telephony Server. See the previous section for
information on how to do this.

To change the lines that an existing user can access, first locate the user account in
the correct Windows NT Server domain in the main window. Next, position the
pointer over the user account name and right-click. This will bring up the following
menu:

2b-34




2b. Installing Smart Control Network For DCS Gateway

I TAPI Administration Application

File User Line Help
= CTITEAM

[ Aadminiztratar

Remove Selected User
- Ty

- wphr
- wpch
- wpids
[l vpecho

LChange Selected Uszer's Line Access

Properties

Figure 2b-46

Click Change Selected User’s Line Access. This will bring up a dialog box filled
with the telephony devices available on this Telephony Server. If the selected user
account already has access to one or more lines, those devices will be highlighted:

Change Line Device Access For Selected User
The TAPI line devices that the user cumently has access to are highlighted.
To add additional lines, hold down the <Chil: key and click on the line to add.

To remove lines, hold down the <Cil> key and click on the line to remaove.

Lire M ame

Tnfores Ling 10|
Infarex Line 11 [1006)

Infrres | ine 2 (20021
A

Switch [nfo
5 ng [NFO
Samzung INFORE:
Samsung INFOREX

Provider Info
Samnsung [NFOR
Samzung INFOREX...
Samsung INFOREX...

Inforex Line 12 [1007]  Samzung INFOREX Samzung INFOREX... 2007
Infarex Line 13 [1008]  Samsung INFOREX  Samsung INFOREx.. 2008
Inforex Ling 14 [1009]  Samsung INFOREX  Samsung INFORE=... 2009
Inforex Line 15 [1010]  Samzung INFOREX Samzung INFOREX... 2010
Infarex Line 16 [1011]  Samsung INFOREX  Samsung INFOREX... 2011
Inforex Ling 17 [1012]  Samsung INFOREX  Samsung INFORE=... 2012
Inforex Line 18 [1013]  Samzung INFOREX Samzung INFORE=... 2013
Infarex Line 19[1014]  Samsung INFOREX ~ Samsung INFORE=.. 2014

Samzunn INFORFX Samzunn INFORF: Annz

Perm Line 1D

Cancel |

Figure 2b-47
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Click the lines to which this user account should have access. You may select more
than one line:

« To select a sequential range of lines, click the line that is first in the range. Then
locate the last line. Then, while holding down the Shift key, click the line that is
last in the range. This will cause all lines from the first to the last to be selected.

o To select more than one line that are not sequential, hold down the Control key
and click each line that the user should have access to.

B TAPI Administration Application [_ (O] %]
Fie Uszer Line Help
B CTITwWO

=)

- Infarex Line 10 [1005) 5amzung INFOREX Samsung INFOREX Service Provider
- Inforex Line 17 [1006) Samzung INFOREX Samsung INFOREX Service Provider
- Inforex Line 12 [1007) Samsung INFOREX 5 amsung INFOREX Service Provider
- Infarex Line 13 [1008) 5amsung INFOREX Samsung INFOREX Service Provider
- Infarex Line 14 [1009) 5amsung INFOREX S amsung INFOREX Service Provider
£ eeles
e lnforex Line 15 [1010) Samsung INFOREX Samzung INFOREX Service Provider
- shlee
- Infarex Line 16 [1011] Samsung INFOREX Samsung INFOREX Service Provider
=- 5150
: - Infarex Line 17 [1012) Samzung INFOREX Samsung INFOREX Service Provider
- ssiung
- Infarex Line 18 [1013) Samsung INFOREX 5 amsung INFOREX Service Provider

Figure 2b-48

When finished, click OK. The main window will be updated to show the updated
list of lines to which the user currently has access.

Changing the Order of Telephony Devices for a User Account

You might want to have a user’s lines viewable in a specific order. For example, an
organization might use a third-party TAPI program that manages calls using the first
available line. If an assistant must answer the supervisor’s phone as well as his own,
it might be preferable for the assistant’s line to be listed before the supervisor’s line.
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To move a particular line up or down in the order of lines for a user, position the
pointer over the line to be moved and right-click. This will bring up the following
menu:

I TAPI Administration Application =]

File User Line Help

=-CTITWO

- inistrator

nforex Line 10 [1005] Samsung IMFOREX Samsung INFOREX Service Provider

nforex Line 11 [100E] Samzung IMFOREX Samsung INFOREX Service Provider
210 S sider:

fervice Provider

ted line up in order FBMCE Pravider

Move the selected line dawn in order

Remave Selected Line

i e lnforex Line 1510

& shlee Properties
i Irfores Line 16 [1011] Samzung INFOREX Samsung INFOREX Service Pravider
- 5150
‘- Inforex Line 17 [1012) Samsung INFOREX Samsung IMFOREX Service Provider
= #5jung

Lo Inforex Line 18 [1013) Samzung INFOREX Samsung INFOREX Service Provider

fervice Provider

Figure 2b-49

Clicking Move the selected line up in order will move the selected line up one
place in order to be positioned over the line that is immediately above it. If the
selected line is already the first in the list of lines for this user, this menu item will be
unavailable (appears dimmed).

Clicking Move the selected line down in order will move the selected line down
one place in order to be positioned under the line that is immediately below it. If the
selected line is already the last in the list of lines for this user, this menu item will be
unavailable (appears dimmed).
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2b.3 How to set MAP for DCS Gateway system

This chapter contains the instructions on how to set the MAP for DCS Gateway
system before starting Samsung TSP V1.0.

MAP(Maintenance & Administration PC) is a program enabling you to correct or
lookup the various values in the database that has been created for operating
and managing the DCS Gateway system. For further information on how to use
MAP, please refer to the user guide available with the MAP program.

It is divided into the following 5 sections on DCS Gateway MAP program :

o Checking the OAI Computer item.

o Setting the LAN Device Register item.
o Specifying the Link Test.

o Specifying the Infolink Version.

o Specifying the OAI Terminal
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2h.3.1

Checking the OAI Computer item

Launch the MAP program to select the menus through paths instructed below :

[System Management] =» [System I/O Device Management] = [I/O Device in
Each Node]

Click the [Rx] button or [F1] button and type the Samsung TSP V1.0 system node
number which is connected to the DCS Gateway system. Then, following screen for
system settings will appear.

# 170 Device in Each Mode/System 1/0 D.., HE E

Hode [ D ]

Mo 140 Device MNode Pt
0 Account Dutput Printer 0 Agync 3
1 System Error Printer
2 Statiztics Output Prinker 0 Agync 3
3
4 Huotel Billing Printer
5 SMDR Output Machine
E |KTEDS
7 | PM52
8 | %MS 0

Check ————# 3 | DAl Computter ] LAN

10 | CAlWVRU

11 | Alarm Box

12 | Remate MAP

13 | RPM

14

15 | System Emor Saving Mode 0

Node [0-7] [0 3] I
| [ Update @@
Figure 2b-50

On the above screen, you should check whether you have properly entered the DCS
Gateway system node number in the Node No. on the OAI COMPUTER item, in
addition, whether you have set the Port No. as “LAN”. If there is found any
incorrect value, correct it.

After completed all the values, click the [Tx] button or [F4] button to store them in
the DCS Gateway system database.
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2h.3.2  Specifying the LAN Device Register item

Launch the MAP program to select the menus through paths instructed below :

[System Management] =» [System I/O Device Management] = [Lan Device
Register]

Click the [Rx] button or [F1] button and type the Samsung TSP V1.0 system node
number which is connected to the DCS Gateway system. Then, following screen for
system settings will appear.

# Lan Device Register/System 1/0 Devi... [HEE

Mode [ 0]
Mo. Device IP Address
0 | Account Printer 1 w2t w3 w28
1 Swstem Ermor Printer [ [ O
2 Statistics Printer B8 w0 2 0 23
zl Haotel Printer (BT e
4 | SMDR1 (6N 1 R =}
5 |[SMDR2 [ )
B Callview 1 L 1§ [ |
7 Callview 2 R IR
8 | PMS (R T o]
9 | VM5 [N 1R 1 O ]
10 | ARS B sl 2 0
Check — 11 | Infalink1 DR SR TR
o |Eee IP &ddress {5 P O |
Fart: 0
IP &ddress 00 08 o O 22
Check ——————# 13 ||PM | SubnetMask | 285 . 255 . 286 . O
Gateway 100 200 = 0w #5
Node[0-7] [0 3] I
[ | Update @@ /
Figure 2b-51

« Enter each value for IP Address, Subnet Mask, Gateway on the IPM item. If
there is found any incorrect value for the IPM board, correct it.

o Onthe IP Address in the Infolink 1, enter the system IP address which has
Samsung TSP V1.0 installed.

After completed all the values, click the [Tx] button or [F4] button to store them in
the DCS Gateway system database.
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2h.3.3  Specifying the Link Test performance

Launch the MAP program to select the menus through paths instructed below :

[Data Base Management] = [ACD& Infolink DB Management]| =» [ACD Service

Option]

Then, following screen for system settings will appear.

# ACD Service Option/ACD & Infolink DB Management/Data Base Management

System Dption I System Mamagement Option I Station Service Option I Trunk Service Option ESPA Service Option I
ATC Service Option I Statiztics/Billing Option I Addition Equipment Option ACD Service Option Hotel Service Option I
Mo. Item Option Input Extenzion Initial =
16 | Agent Reservation Method [0: Count/Others: R atia] Count
17 | ACD PC RTC Setting cycle [Select]
18 | Dvermide Display O [Yesz/Ma] Yes
19 | Service Digit Length [1-4] 3
20 | Service Digit Prefix [0x00 - 0x0b/ 4-Digit]
21 | ACD Statistics Link [DTIR/LAN] DTIR
2
23 | Node 0 ACD Mode [ICD/ACD] ACD
24 | Node 1 ACD Mode [ICD/ACD] ACD
28 | Mode 2 ACD Mode [ICD/ACD] ACD
26 | Mode 3ACD Mode [ICD/ACD] ACD
27 | Node 4 ACD Mode [ICD/ACD] ACD
28 | Node 5ACD Mode [ICD/ACD] ACD
29 | Mode B ACD Mode [ICD/ACD] ACD
30 | Mode 7 ACD Mode [ICD/ACD] ACD
Check ——— | 31 | Link Test | [YesiMo] No j
i
[ Update @@
Figure 2b-52

On the above screen, you should click the Option select box on the Link Test item.

If there is found any incorrect value, correct it.

After completed all the values, click the [Tx] button or [F4] button to store them in

the DCS Gateway system database.
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2h.3.4

2h.3.5

Mo Itermn Content
1] Site |dentification 123456
1 Remote tManage. Admin. Tel
2 Modem Anzwer Time [zec] 0
3 SMDR Print Type Office
4 Country Code Country 13
5 Frinter Size 132 Column
B SMDR Format Tranzfer Call lgnare
Check —— 7 Infalink Wersion Flexible Format{y340~] d
ined Format
o
[ Update (@@ ~

Specifying the Infolink Version

Launch the MAP program to select the menus through paths instructed below :
[Data Base Management] = [System DB Management [] = [[PM Info.]

Then, following screen for system settings will appear.

#* IPM Info./System DB Management |/Data Base Ma... HIEE3

Figure 2b-53

On the above screen, you should specify Flexible Format(V340 ~) on the Infolink
Version. (For the efficiency, you should specify as Flexible Format to handle the
string as long as message length.)

Specifying the OAI Terminal

DCS Gateway is a large capacity PABX system. If event occurs per telephone
subscriber, the system operation is delayed by a congestion of message. To prevent
a congestion of message, you must specify the terminal provided CTI service as
OALI terminal.
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Launch the MAP program to select the Port Information (Total) menu.

Select the [Tel. Rx] tab at the Port Information (Total) screen and enter the tenant
number and the telephone number of terminal that provide CTI services. Click the
[Rx] button. Then, the data of the telephone number will display as follows.

Port Information (Total} . =10 x|
Node [1] Poit [ ] Tenant [ 0] Tel [ 5000 ] Port Type |1E PortVoice DGP 'l
Port Type 16 Part Yoice DGP Pick Group Mo, ﬂ
Physical Part Type Pilat Mo
ACD Group No. FRiing Group No.
COM Group Mo, Ring Pilat MHo
Cantrol Group Mo, Fioom Group Mo, :l
Fax Port R2 Bill/MonBill Signal Bill Signal ;I
Fan Tel WIF O
Special Service ALCD Agent MOH Index [0 - B3]
ACD Priarity [0 - 4] o Mo &ns. Time-Out [0 - 999 sec] 80 —I
Bill Pay Method Alfter-Pay Parking Station Park. Check
Billing Tel. PreSelect ID [0 - 15] 1]
Billing Type Marmal PvMS Group Mot Use LI
M e
ALC Threshold [0 - 7] 4 MNoise Guard [0 - 7] 4 o
Beep Tone [0-7] 2 Moige Threshold [0 - 7] 2
Bell Tone [0 - 7] 2 Ringer Frequency [0 - 15] T
Digit Tone Enable DTHMF Rx Level [0- 7] 2
Dizplay Mode English Side Tone Level [0- 7] 2 :l
Mode/Paort e Tel R I Part Delete TKI
Tenant [I 2] Tel. [5000 ) BN
| | Update (@@ ~
Figure 2b-54

On the above screen, you should click the Option select box on the OAI Terminal
item. If there is found any incorrect value, correct it.

After completed all the values, click the [Tx] button or [F4] button to store them in
the DCS Gateway system database.
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2b.4 Troubleshooting

If you have problems running Smart Control Network V4.1, look through the
problem checklist below.

Symptom or Error Message Resolution

e s o Smart Control receives a error code during
TAPI can not be initialized,

. calling the line Initialize function
Please try after some time

i o Check the Telephony Client Configuration

TAPI has not been setup

. e Smart Control receives a error code during
properly in your system, Please

calling the line Initialize function

configure TAPI and run | ) ]

SmartControl i o Check the Telephony Client Configuration
''''''''''''''''''''''''' " e You did not have any assigned line from

No lines have been assigned to telephony server

you!! e Request some assigned lines to your

i Telephony Server Administrator

S e You did not configure the Telephony Client

Fail to open the line Configuration.

i & Run tcmsetup.exe and refer its help file.

____________________________________ e
1

o Check your telephony dialing parameters

Unable to make Outgoing Calls
from the Control Panel

Table 2-1
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What will You See When You Start Smart
Control Network V4.17?

When Smart Control is run for the first time a dialog “Select Your Phone” will
appear allowing the user to select a phone line from a set of lines configured for him.

Select Your Phone (%]

Lines:

|DCS Line 201 =l
Address:

|am =]

" Service Provider [nfio

Samzung DCS Service Provider
Help |

Figure 3-1
After selection of a Phone Line , the same line will be opened each time the Smart
Control is run. The USER has got the option of changing the Phone Line by

selecting [PhoneLine.. Joption from the Main menu under the [Option] menu item.

The “Selecting Phone Line Dialog Box” Which appears on selection is shown
below.

When you start Smart Control Network V4.1, the main screen is displayed.
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!!'. Smart Control Network W4.1 - Administrator - 201
File Edt Directory CallControl  Station Setup  Option  Wiew Help
D = @ m O% % w General
= - ToolBar
a
@ -b E'f-’ = @ Station
Control
E@ Smart Cantrol Mame | Company | Office Phone Bar
E@ Directory Selection
Local View
@ Business ) ;
@ FindReslts Eie:"ta:.lr?:w
@& Other
LAl Personal
@& Scheduler
@ CallLog
N [ 2
I I =1
TR T Bleg @ @@
| Call Control
- View
Murnber | M ame | Statug | Diuration
J I I ﬂ Status
[ Bar
Ready [AutoAns [Locked [CallBack fo.L 4
Figure 3-2
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The table below describes the items shown in Figure 3-2:

Item i Purpose

+ Shows the status of your application i.e. either your System
Status i Name & Telephone Extension you selected or any Vacant
Station message left by keyset.

' Shows the different menu options categorized by the services

Menu Bar ' provided
"""""""""" . There are two Tool Bars in Smart Control Network V41,2
fixed General Tool Bar and a dockable Station Control tool Bar.
You can choose from any of the three sizes of the Station
: Control Tool Bar.
Tool Bar I

Using the General Tool Bar you can perform Services (i.e.
Directory, Call Log & Scheduler) based operations.

Using Station Control Tool Bar you can perform station
features related operations like DND, Call Forward etc.
"""""""""" ' Selection View is used to access various Smart Control
' Network V4.1 services. You can access these services in two
Selection View ways:
1. Tree view — Default view
2. Icon view
""""""""""  You can view the detailed contents of all the Smart Control
i Network V4.1 services. The Personal PhoneBook is selected by
default. In Detailed List View, Directory Services displays the
contents of all the contacts. Its contents are as follows:

e Name
Detailed List

‘e Compan
View ' pany

io Office phone

o Office phone extension
i- Home phone

i e Mobile

i- Pager number
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' Scheduler Services displays the contents of all the scheduled
+item. Its contents are as follows:

‘e Function
e Details
i- Frequency

Detailed List
View

e Time
o State of Schedule

~ Call Log Services displays the contents of all the logged calls.
Its contents are as follows:

e Name
Detailed List ¢ From/To
View i Date
e Duration
e Status
e Identifier
1o Call Note
‘Call Control | You can perform call control options like dialing, transferring a
View call, conferencing, etc.
T Y ou can see the current status of your telephone such as DND,
Call Forward, Msg List (list of stations that left messages), Call
Status Bar Back (station on which Call Back is set.), and whether your
! station is currently locked. You can also see the current time on

the Status Bar.

Table 3-1
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3.1

Tool Bar

3.11

3.1.1.1

There are two Tool Bars in Smart Control Network V4.1,

« General Tool Bar
« Station Control Tool Bar

General Tool Bar

The General Tool Bar, depending upon the services currently selected (i.e. Directory
or Scheduler or Call Log), helps you to perform operations related to these services.

O X 8 X =

The function of each Tool Bar button with respect to the context of the currently
selected services is as follows:

General Tool Bar for Directory Services

If Directory Services is currently selected then you can perform the following
operations using the General Tool Bar.

D Add Contact button — To add new contact record to your current book.

Update Contact button — To update the currently selected contact record
in the current book.

@ Delete Contact button — To delete the currently selected contact record
== 1 | in the current book.
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m Delete All button - To delete all contact records of current book.

O% Search button — To search for text entered by a user in the contact
——~1 | records of the current book.

I%l Print button — To print the contact records information of the current
~="1 | book.

Table 3-2

3.1.1.2 General Tool Bar for Scheduler services

If Scheduler Services is currently selected, you can perform the following
operations using the General Tool Bar.

[ Schedule button — To add a new schedule to the schedule list.

= Update Schedule button - To update the currently selected schedule in
2 the schedule list.

@ Delete button — To delete the currently selected schedule in the schedule
LB | st

=1 | Print button - Disabled.

Table 3-3
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3.1.1.3 General Tool Bar for Call Log Services

If Call Log Services is currently selected, you can perform the following operations
using the General Tool Bar.

Add button — Disabled.

% Print button — To print the Call Log records.

Table 34

3.1.2  Station Control Tool Bar

The Station Control Tool Bar helps you to set station features such as DND, Call
Forward etc. It is a dockable tool bar with three different sizes: small, large and large
with text (see below). You can select any one of these sizes from the View/Tool Bar
menu.

Small

@ &

Wl @ El [k
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Large
@ =
Large With Text

@ &

DMD  Forward

iy P

Iy o i

[CEENME -
Answer EElEECES MEgy  Medlist

The following table explains the operations that can be performed using buttons of
any of these Tool Bars.

@ DND button — To Set/Reset DND.

i Auto Answer button - To set auto answer options for different call
3 J types

L Call Back button — To set a call back on currently dialed busy or non-
= answering station.

@ Leave Message button - To leave a message on currently dialed non-
answering station.

@‘ Message List button — To view a list of messages set on your station
o by other station.

Table 3-5
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3.2 Status Bar

The Status Bar shows the status of your station such as DND (Do Not Disturb),
Locked, Msg List (list of stations that left messages), etc. if you set your station
parameters with various features supported by your DCS Keyset . The illustration
below shows the Status Bar as you might see it.

| eady ocke on busy to :
Read: Locked PwD b 204 DND 1:22 PH

The highlighted panes indicate that the corresponding features are set. You can
change the Colors of the panes (see “How Do You Change Color of Status Bar
Panes?” in Section 4).

Status Description
Indicates AutoAnswer set for any call types like Internal, External,
' Hold Recall etc.

Locked ' When the station is Locked.

______________ e e e e e

Callback  : If your station has set a call back on some other station.

_________________________________________________________________________________________

Msg. list i If some other station has set a message for you.
Call o
. If you have set Call Forwarding or any other station has set Follow
Forwarding !
type |
DND  If you have set your station to Do Not Disturb mode.

Table 3-6
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o Set/reset of station feature made easy
You can set/reset the above station features by double clicking in the corresponding

pane.The first pane is the Ready pane for showing prompt messages. The last pane
shows the current system time.

3.3 Views of Smart Control Network V4.1

3.3.1  Tree View

If you select the Tree view from View option, the Selection View will display the
services in the tree structure shown below.

E@ Smart Control
E@ Directory
=@ Local

Scheduler
Call Log

Figure 3-2
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3.3.2

3.3.3

Icon View

If you select the Icon view from View option, the Selection View will display the
services in the icon structure shown below.

E v w

= Business FindResults
%
=X =
ﬁ Other Fersanal
Figure 3-3

Hidden View

If you select the Hide View option, the Smart Control Network V4.1 Selection View
will be hidden and only the Detailed List View will be shown. Click Show View, if
you want Selection View in view. You can also click the right mouse button to get
Hide option.

1
Mame I Compary | Office Phone I Extn | Home Phone | Mobile
FinMicheal HCommunications 1-801-55505556
Fin Peter StarMet 1-504-44424444

4 |

Figure 34
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4. Configuration

4. Configuration

You can set various options provided in the Smart Control Network V4.1 software
using the submenus under the Option menu.

Option | Purpose

To notify you about caller detail and Database
: Option between Smart Control and Outlook
1 To set the DDE Option about displaying the Contact

Call Notification Method

DDE ! .
+ Information
Phone Lines i To select the Device and Address assigned for you.
‘Set Environment |
. . + To set speed dial numbers.
-> Edit Speed Dial ... 5 P
‘Set Environment e
' To set fast pick up numbers
-> Fast Pick Up Edit... ! piekup
Set Environment ;
' To set page zone names
-> Page Zone Name... ;

Set Envi t > Ch |
cL EnvIronmen ME 1o change the Color of the Status Bar panes.
Pane Text Color... :

'
________________________________ e

Set Environment : . . . .
. ' To set the time out time for various services
- Time Out... !
‘Set Environment L o L o
. 1 To enable/disable the Window Tray option
- Window... ;

Table 4-1
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4.1 How do you set up Call Notification?

Click on the Options menu and select the Call Notification Method. A Call
Notification dialogue box appears, in which you can select the options.

Call Notification
General | Database |

— Dizplay Call Detail:

W For Incoming ntemal Calls

™ For Dutgoing Calls

— On Incaoming Call
¥ Bring Smart Control to front

™ Play Sound For Incoming Call

File Marne: dist |

I Browee

|

| VDK I |xtame1| Help |

Figure 4-1

4.1.1  How Do You Configure General Options?

4.1.1.1 How Do You Display Incoming Call Details

For External Calls

Select the For Incoming External Call option, if you want to identify the external
caller. A dialogue box, or property sheet, will appear (Figure 4-2), with which you
can identify the caller if the caller’s number is available in the Directory database.
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4.1.1.2

For Internal Calls

Select the For Incoming Internal Call option, if you want to identify the internal
caller. A dialogue box, or Property sheet, will appear (Figure 4-2), with which you
can identify the caller if the caller’s number is available in the Directory database.

David

Personal Info | Contact Info. I

Mame ID avid

Company Mame |><Communication Ltd.

JohTitle IF'roiect M anager j

Department IN etworking

[ Otfice Address ~ |

Browse ... | Edit Address ... I
Note | Email | |
|V’ﬁ_1gr | |anncel|
Figure 4-2

If there are more than one contact in the Directory database, which matches the
incoming phone number, then, the first contact which matches will be shown.

How Do You Get Details for Outgoing Internal Calls?

Select the For Outgoing Calls option, if you want to identify the outgoing called
number. A dialogue box will appear with which you can identify the number, if the
given number data is available in the Directory database.
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4.1.1.3

4.1.14

412

How Do You Bring Smart Control Network V4.1 to the Front for an
Incoming Call?

Select the Bring Smart Control Network V4.1 to Front option, if you want Smart
Control Network V4.1 to be maximized automatically on an incoming call, while it
is running in the minimized mode. The application also comes to the front if it’s in
the background. If this option is not selected, for an incoming call the minimized
Smart Control Network V4.1 window flashes.

How Do You Play a Sound File for an Incoming Call?

Clicking on the Play Sound for Incoming Call option, if a call comes in, causes a
sound file to be played through the multimedia card on the PC. You can select the
*.wav file by clicking the Browse button and selecting the wave file from the Open
dialogue box. You can test the wave file that you have selected by clicking the Test
button.

How Do You Configure Database Options?

Call Notification

General Database |

¥ Search Smart Control Contacts

™ Search Dutlook Contacts

| VDK I |anmce1| Help |

Figure 4-3
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4.1.2.1

If you set the Display Call Details options above, the Smart Control searches for
some databases to get calling or called party records with phone number as a key.
You can choose which database to search in this option. Currently Smart Control
supports the Smart Control Contacts and Outlook Contacts.

If you want to use other PIMs refer to the “DDE (Dynamic Data Exchange) support
in Smart Control Network V4.1 (Section 11)”.

How Do You Configure Outlook Contacts Searching Properties?

The Properties button displays a page that gives details for the Outlook
Contacts searching options.

Database Telephone Maszk Formats

— Contact Database

Folder Mame : IEontacts Briowse... |

—Mask Formats
Mew Magk : I

Add Bemae
Available :
Add Bemae |
Achive . [s00e 3 ﬂ
e
RN 020900 =

Cancel |

Figure 44

Mask Formats:

You can convert the phone number for Outlook contacts searching by setting
some masks. Enter a new mask in the New Mask edit box and click on the Add
button, then it will be appended in the Available box. If you selected a mask in
the Available box and click on the add button below the box, the mask will be
activated and appended to the Active box.
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The Smart Control allows +, -, (,), 0~9, B (representing a blank), and X (a wild
character) to compose a mask.

For eg:

Phone Number saved Mask

In the Outlook Contacts
+82 (331) 218 7429 +XXB (XXX) BXXXBXXXX
+1 (972) 716-7011 +XB (XXX) BXXX-XXXX

+1B (XXX) BXXX-XXXX

(972) 716-7011 (XXX) BXXX-XXXX
+61 (9) 1234567 +XXB (X) BXXXXXX
203 (internal) XXX

If you want to deactivate a mask, select the mask in the Active box and click on
the remove button above the box. The selected mask will be moved into the
Available box. If you want to completely remove a mask, move the mask into
the Available box first. Then, choose the mask in the Available box and click on
the remove button above the Available box.

1. The Smart Control generates a CallerID or a CalledID, that is a phone
number, including country code and area code except STA version. Be sure
that country code and area code are included in the Outlook contact records.

2. The Outlook program inserts some blanks into the phone number
automatically. You should include those blanks in the mask to search those
records.

3. The Smart Control and Outlook both get your location information from the
Telephony settings of  your Windows system.

4. Do not include leading ‘0’ in the area code if you have one.

Contact Database:
You can choose the folder in which the record to be searched. It is set Contacts

folder by default. If you want to change, click on the Browse button. The following
dialog box will appear.




4. Configuration

Contact Databasze Information

Outlook: adminiztratar

----- ticrozoft Mail Shared Folders
[l Personal Folders
----- Deleted ltems

- Buginess
o Friends

[oc ]

Cancel

Figure 4-5

The Contact Database Information dialog box will show all the folders of your

Outlook program. You can select only contacts folder or its sub folders.
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4.2 How Do You Change DDE Options?

To change DDE (Dynamic Data Exchange) related options, select Option
-->DDE... option from the Option menu.

Check the “Enable DDE for Incoming Calls” check box if you want DDE for
incoming calls. You can specify the call type, i.e. enable DDE for internal incoming
calls or external incoming calls or both. You can also specify whether the contact
search should be based on Caller ID or DNIS (Dialed Number Identification
Services).

Select the database application, such as Symantec ACT! 2.0, GoldMine4.0 etc, of
your choice. Enter the selected application’s EXE file path in the program’s “Path”
box. You can even browse to find the EXE file using the Browse button.

Enter the database file in the database’s “Path” box. This is the file that contains
your contact records. The Test button helps you to check whether you have entered
the selected application’s EXE file path properly. See “DDE Support in Smart
Control Network V4.1” (Section 11) for more information.




4. Configuration

4.3 How Do You Change Phone Lines Options?

To change the current used phone line, select Option --> Phone Lines... option from
the Option menu.

Select Your Phone (%]
Lires:
|DCS Line 201 =l
Address:

| 2m j Cancel |

" Service Provider [nfo

Samsung DCS Service Provider
Heb |

Figure 4-4

From the above dialog box, “Lines” means the current selected line and “Address”
means the real phone address.

Select Your Phone (%]
Lires:
DS Line 201 2o oo |
DCS Line 201 -
DCS Line 202

DCS Line 203 Cangel
DS Line 204 4|

DS Line 205
DS Line 206
DS Line 207 = |
DCS Line 208 - fep

Figure 4-5

When you select the dropdown button of Lines, You will see line list you can select.
This line list is assigned by Telephony Server Administrator with Tapi Client
Management Tool : tcmapp.exe. When you try to run Smart Control Network V4.1
on Telephony Server, you can select all lines supported by Samsung Telephony

Service Provider. However, you have to select the normal line (2XXX, 3XXX) like
your real phone.
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After changing the current line (201 = 202), you can see the next dialog box.

Smart Control (%]

& DCS Line 201 has been closed!

Figure 4-6

Smart Control

& DCS Line 202 has been opened|

Figure 4-7

And next, you can use the changed line.
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4.4 How Do You Configure Speed Dial Numbers?

Click on Option menu and select Option = Set Environment - Speed Dial Edit
option. An Edit Speed Dial dialogue box will appear, in which you have five default
buttons. You can select the speed dial button you want to program by clicking on the
button. This will allow you to enter the telephone number and button name in the
fields at the bottom of the window.

Set Environment

Page Zone Mames | Change Pane Text Calor | Time Out I Windom
Edit Speed Dial | Edit Fast Station Fickup

Choose a Button from the group belaw

Enter the name and number fior the selected button

Mame Murnber ta Dial

- [

| VDK I |XCance'|| Help |

Figure 4-8

Once you have entered the name of the contact in the Name field and the number in
Number to dial field, click on the OK button. These speed dial numbers would be
available in the Dial pad, Transfer pad and Conference pad for one-touch dialing,
transferring and conferencing respectively.

If you wish to configure more than one number, just click on the next button you
want to program after you have finished entering data for the current button. You
can also edit the speed dial name and number by clicking on any button and editing
it in the respective fields.

4-11
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4.5 How do you set Fast Pick Up Numbers?

Select the Option = Set Environment = Fast Pick Up Numbers option from the
Option menu to set fast pick up numbers in the Fast Pickup Edit dialogue box.

Set Environment

Page Zone Mames | Change Pane Text Calor | Time Out I Windo |
Edit Speed Dial Edit Fast Station Pickup

Choosze a Buttan from the group belaw

R |
Samsung | Park. |
Kirn |

Enter the name and number for the selected button

Mame Station Mo. to Pickup

[ [ ]

| VDK I |XCance'|| Help |

Figure 4-9

Once you have entered the name of the contact in the Name field and the number in
Number to dial field, click on the OK button.
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4.6 How Do You Set Page Zone Name?

Select the Option = Set Environment = Page Zone Name option from the Option
menu to set Page Zone Name in the Page Zone Names dialogue box.

Set Environment
Change Pane Text Calor I Time Out | Wwindaw |
EditSpeedDial | FastPickup Edit Page Zone Names
Paging Zone:

Zone Mame:

| VDK I |XCance'|| Help |

Figure 4-10

Select the zone you want to set and click on OK.
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4.7 How Do You Change Pane Text Color of
Status Bar Panes?

To change the Status Bar pane Colors, select Option = Set Environment = Pane
Text Color... option from the Option menu. A Change Pane Text Color dialogue
box appears. The Colored buttons show the pane text Colors presently selected for
the Status Bar panes. Click the button corresponding to the station feature pane
whose Color you want to change. Select the Color from the Colors dialogue box.

Set Environment
Edit Speed Dial | Fazt Pickup Edit I Page Zone Mames
Change Pane Text Color | Time Out | Window

Ready Pane Message Pane

I
|

Auta Anzwer Pane Fomward Pane

I
|

Locked Pane DHD Pane

|
|

CallBack Pane Time Pane

[—

I

| VDK I |xCancell Help |

Figure 4-11
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4. Configuration

4.8 How Do You Set the Time QOut Parameters?

Click on the Options menu and choose the Option = Set Environment = Time Out
option. A Time Out dialogue box will appear. Set the Time Out against the options
available. You can set the time out, in seconds, for the Auto Answer, Clear Call and
Dial Duration (retry) intervals.

Set Environment
Edit Speed Dial I Fazt Pickup Edit | Page Zone Mames
Change Pane Text Calor Time Out I Windaw

Auta Anzwer(zec] |3 ﬂ
Clear Callisec) |1 j
Dial Duration[sec) |3U j

| VDK I |xCancell Help |

Figure 4-12

Option E Purpose
' Sets the time for the Smart Control Network V4.1 to answer
' automatically

_________________________________________________________________________________________

Auto Answer

Dial Duration | Sets the time to retry, if you want to dial continuously

Table 4-2
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4.8.1

4.8.2

4.8.3

How Do You Set Time Out for Auto Answer?

The timer value entered in this field determines the delay before the program will
automatically answer a call if that type of call has been flagged for Auto Answer.
You can enter the time out value in the AutoAnswer field of the Time Out dialogue
as shown above.

How Do You Set Time Out for Clear Call?

The timer value entered in this field determines the length of time the Call Control
window will remain open, allowing notes to be made or a keyword to be entered
after the call has been disconnected. You can enter the time out value in the Clear
Call field of the Time Out dialogue as shown above.

How Do You Set Dial Duration for Continuous Dialing?

The timer value entered in this field determines the length of time the application
will wait before redialing when the Continuous Dial feature has been activated. You
can enter the retry value in the Dial Duration field of the Time Out dialogue as
shown above.
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4.9

How Do You Set Windows Options

When you want to load the Smart Control Network V4.1 into System Tray, Mark
this option.

Set Environment

Edit Speed Dial | Fast Pickup Edit I Page Zone Mamesz |
Chatge Pane Test Color I Tirme Out ‘window

™ Show SmartContol in System Tray

|VDK I |XCance'|| ﬂl

Figure 4-13
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5. Station Setup

5. Station Setup

You can set your station parameters with various features supported by your DCS
Keyset. This menu has the following options.

Item | Purpose
Station 5 . . .
Lock/Unlock : Locks/Unlocks the station from making or receiving any call
Do Not Disturb i Sets/Resets your station to Do Not Disturb mode
Call Forward + Forwards calls from your station to another station
Follow Me i Redirects calls from other station to your station
T i Displays the list of messages left by other station on your
Message List ' p Y g Y 4
station
Cal 1' Back Stams b Displays the station number or trunk number on which you
: have set a call back.
Auto Answer ' To auto answer after the set time out
‘Auto Trunk Call &~ o o
le:ck + To set trunk call back automatically when trunk is busy

Table 5-1
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5.1 How Do You Set a Station Lock/Unlock?

.11

5.1.2

How Do You Set a Station Lock?

You can lock your station using the Station Lock option. This prevents other people
from making calls from your station, in your absence. It also prevents you from
receiving incoming calls.

Station Lock

Enter the password ||

| VDK I |anncel| Help |

Figure 5-1

Once you click on the Station Lock option, a Station Lock dialogue box will appear.
Enter your password and click OK to lock your station. You can also double click in
the Locked pane of the Status Bar to change Station Lock/Unlock.

How Do You Unlock Your Station?

To unlock your station, click Station Unlock option in the Station Setup menu and
enter the password or double click in the Locked pane of the Status Bar to enter the
password in the dialogue box.
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5. Station Setup

5.2 How Do You Set Your Station to Do Not

521

5.2.2

5.2.3

5.24

Disturb Mode?

If you do not want to be disturbed with incoming calls you can set your station to Do
Not Disturb (DND) mode.

How Do You Set/Reset DND on Your Station from Station
Setup Menu?

Click on Station Setup menu and select DND option. If there is an incoming call
when you have set your station to DND mode, the caller will get a DND message.
To reset your station from DND mode, select the DND option from the Station
Setup menu again.

How Do You Set/Reset DND on Your Station from Status Bar?

You have the easy option of double clicking in the DND pane of the Status Bar to
Set /Reset DND.

How Do You Set/Reset DND Using Hot Key?

Press F8 function key to set your station to DND mode. To reset your station back to
normal mode press F8 function key again.

How Do You Set/Reset DND from the Tool Bar?

@

Click on the Do Not Disturb button on the Station Control Tool Bar to set your
station to DND mode. To reset from DND mode, press this button again. If DND is
set for your station, the Status Bar will display this.
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5.3 How Do You Set Call Forwarding?

531

5.3.2

You can forward internal and external calls to another station. You can also forward
your calls from an external party to an external telephone number.

How Do You Set Call Forwarding from the Station Setup Menu?

Click on Station Setup menu and select Call Forward option. The Call Forward
dialogue box will appear (Figure 5-2).

How Do You Set Call Forwarding from Status Bar?

You have the easy option of double clicking in the Forward pane of the Status Bar to
get the Call Forward dialogue box.

Call Forward

Fanmard Type Fonward To

© Al Calls [ =
" On Bumy I—L,
' On No Answer lﬁ
' On Busy/No Answer lﬁ
" External Calls lﬁ
£ WD) Faryard lﬁ

Set Elearglll LCancel | Help |

Figure 5-2




5. Station Setup

5.3.3

5.34

Option ! Purpose

All Calls "Forward all Incoming calls

_________________________________________________________________________________________

_________________________________________________________________________________________

On Busy/No  :If Busy or No Answer Data is existed and you select this,Busy
Answer ' & No Answer is set to the same number.

External Calls | Forward your external calls to an external number
i Forward incoming calls to another station, if your station is set
DND Forward i to DND mode (this option may not be selectable on your

system)

Table 5-2

Enter the Forward Type of call you want to forward. Enter the number of the other
station in Forward To field and click on Set button to enable the Call Forward. You
can also select the station from the Call Forward selection list to choose any of the
previously entered numbers.

How Do You Set Call Forwarding from the Tool Bar?

i
Click on the Call Forward Tool Bar button to get the Call Forward dialogue box.
Select the type of call you want to forward and enter the number in the selection list.

Click on Set button.

How Do You Reset Call Forwarding?

Click on Station Setup menu and select Call Forward option. The Call Forward
dialogue box will appear. Click on the Clear button to clear all types of call
forwarding at your station.
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Click on the Call Forward Tool Bar button to get the Call Forward dialogue box.
Click on the Clear button to clear all types of call forwarding at your station. If
forwarding is set for any type of call, the Status Bar of your station will display this.
You can also double click on this highlighted pane of your Status Bar to get the Call
Forward dialogue box.

5.4 How Do You Redirect Calls to Follow You?

You can redirect your calls from another station to your current station. Click on
Station Setup menu and select Follow Me option. This will display the Follow Me
dialogue box. Enter station number from which all the calls will be forwarded to you.
If there is an incoming call at that station, the call will be redirected to your station.

Follow Me (%]

Station that should Fallow: I
| VDK I |xCance]| Help |

Figure 5-3




5. Station Setup

5.5 How Do You Check Your Station’s Message
List?

Click on the Station Setup menu and select the Message List option to check
whether any other station has left a message for you when your station was busy or
when you did not answer. The message list will contain the station number which
has left the message for you. Station Setup menu’s Message List option will be
disabled if no station has left a message for you.

You can select the station and call the station back by clicking the Call button. You
can clear the selected message by clicking the Clear button or clear all the messages
by selecting the Clear All button. The Status Bar will show Msg List if another
station has left a message on your station. Double click in the highlighted pane of
the Status Bar to get the Waiting Messages dialogue box. You can also use the
Station Control Tool Bar’s Message List button to get the dialogue box.

Waiting Messages

Messages Left By :

205
Clgar
Clear &l
Cloze

Help

_ e |
[E=a |
[Es |
_ ek |

Figure 54
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5.6 How Do You Check Your Station’s Call Back
Status?

Click on the Station Setup menu and select the Call Back Status. .. option to check
whether you have left a call back message on any other station. This option will be
enabled only if you have set a Call Back on some other station. A Call Back
dialogue box will appear showing the station number.

Press Clear button if you wish to clear the Call Back to this station.

Call Back =]
Call Back Set Or: Clear &1 |
208 j

oK |
Help |

Figure 5-5

The Status Bar will show CallBack, if you have set call back on some other station.
Double click in this highlighted pane to get the above dialogue box. If you have set
call back on more than one station you can clear them one by one if needed.




5. Station Setup

5.7 How Do You Set Smart Control Network
V4.1 to Auto Answer?

Click on the Station Setup menu and choose the Auto Answer option. You can

select the type of call you want the station to auto answer from Call Types in the
Auto Answer dialogue box.

—Call Types————
[~ Callback

[ Internal Call
" Hold Recall
™ Transfer Recal

[~ Estemal Call

| MU-K} I |xCancell Help |

Figure 5-8

If any of the Call Types options is selected, Smart Control Network V4.1 will
automatically answer that type of call after the time which is set in the Time Out
option. You have the option of double clicking in the AutoAns pane of the Status
Bar to change Auto Answer options.
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5.8 How Do You Set Auto Trunk Call Back?

To set trunk call back automatically, select the Auto Trunk Call Back option from
the Station Setup menu. To deselect the option click on the Auto Trunk Call Back
option again. Note that Auto Trunk Call Back doesn’t work during conference call
and transfer call.

5-10




6. Call Control Services

6. Call Control Services

This chapter tells you about the Call Control Services. The bottom half of the menu
screen is called the Call Control View. The Call Control View is used to access call
control related services.

IR v S~
'%J DR TE - X @' @ @ \nd
Mumber | Name | Status | Ciuration | Reason
4| | i
Ready [AutoAns [Locked [CallBack [Msg_ List [No FWD Types [DND [8:20 PM 2l
Figure 6-1

The call view has buttons for various call control functions and a call list to display
the calls at the station.

« Call List
Header Purpose
' For external calls, shows the caller id, if available; else it shows
 the trunk number and the DNIS (Dialed Number Identification
Number ! . . . . .
1 Services), also if available. For internal calls, shows the station
number.
Name Shows the name of the connected party.
: Shows the status: incoming call, On Hold, On Hold pending
Status ! .
' transfer, On Hold pending Conference etc.
Duration | Shows the connected duration of the call
Reason + Shows whether the call is a Recall, Call Back, etc.

Table 6-1
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« Call Control View Buttons

Buttons ! Purpose

‘%ﬂ To make a call

_________________________________________________________________________________________

ﬁ ' To hold an active call
%:_. To transfer an active call

_________________________________________________________________________________________

ﬁ - To Toggle between calls (Consultation Transfer Case Only)

'
________________ g

(é To Redial the last number

_________________________________________________________________________________________

_________________________________________________________________________________________

Table 6-2
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6. Call Control Services

« Call Control Menu

Options Purpose
Dial To make an Outgoing call or to dial on the current call
"Answer | To answer an incoming call or retrieve a held call
Release  |Toreleaseanactivecall
‘Redial iToredial the last dialed number
‘Hold ~ [Toholdanactivecall
‘Transfer | Totransfer acall to another station
‘Conference | Toconference
I];/ilgfnflega 1 ' To make an Outgoing new external call
C(.)nt.muous To continuously dial the last dialed number
Dialing
‘Rediect | Toredirect the incoming call to another staion
Park | Toparkthe trunk call to another station
PickUp i To pick up a call from another station/group
Toggle . Totoggle betweentwocalls
‘Page | ' Topageazone
‘Send DTMF ! To send DTMF Tones
"CallBack | To set the busy/no answer station to call back
‘Leave | To leave a message for a busy station or a station which does not
Message answer
‘CampOn | To indicate a busy station that your call is waiting
'OHVA ! Tointrude into a busy staion

Table 6-3
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6.1 How Do You Make a Call?

6.1.1 How Do You Make a Call from the Call Control Menu?

Click on the Dial option and the Dial dialogue box will appear.

Dial
~Speed Dial
[ =l P
1 John |
1z | nzn:: I]EFl David |
ﬂd : ; Q%Send Z avil
GHI| m_l mml =>| (3 Richard |
7 § | 9 4 Marshall |
PRS | TUV | wxy
Cancel 5 Ryu |
R [ R
Help
Figure 6-2

Click on the numbers in the dial pad and click on the Send button to make a call.
You can click on the pull-down menu to select and dial any of the last 10 numbers
you have dialed previously.

You can also click on any of the Speed Dial buttons for quicker access.

6.1.2 How Do You Make a Call Using Hot Key?

You can press the F2 function key to get the Dial dialogue box to make a call.

6.1.3  How Do You Make a Call from Call Control View?
2z

Click on the Dial icon in the Call Control View to get the Dial dialogue box to make
acall.




6. Call Control Services

6.1.4

6.1.4.1

6.1.4.2

6.1.4.3

Other Ways of Making a Call

How do you make a call using Drag and Drop?

Select the contact to whom you want to make a call in the Detailed List View, when
in Directory Services. Drag and drop the contact into the Call Control View to make
the call. Office phone is the default number dialed. If you drag from the home,
mobile or the pager column, the respective phone numbers will be dialed.

How do you make call from the property sheet?

Double click on any contact in the Detailed List View to be dialed. Select Contact

Info from the Update Record dialog box. Click on this @ icon to dial the number
against it.

How do you make a call using the right click menu?

Select the contact to whom you want to dial in the Detailed List View and click the
right mouse button. A pop-up menu will appear. Select the Dial option to dial the
contact’s office number.




Smart Control Network Version 4.1 User Manual

6.2 How Do You Answer a Call?

When there is an incoming call, the status of the call is shown in the Call Control
View. If there is more than one call in the call list, you can select the call to answer.

¥ YE T BEeeE @@

Humber | Wame | Status | Diuration | Fieazon |
il 202 Incaming Cal
Figure 6-3

When an incoming call is received from a station, Smart Control Network V4.1 will
display the station number and the name of the station, if it is set, and the type of the
call if it is not a direct call.

When an external incoming call is received by Smart Control Network V4.1, it
displays:

1. The trunk number, if the caller id is not available.

¥ Y E T e ®E P

Eumbel | MName | Status I Duration! Feason
il 702 Incarming Call
Figure 6-4




6. Call Control Services

6.2.1

6.2.2

2. The caller id, if it is available.

¥ Y E T e ®E P

Eumbel | MName | Status I Duration ! Feason
}# 802215391 Ananth Kiishnan — Incoming Call
Figure 6-5

3. The caller id and called id (DNIS), if they are available.

¥ Y E T e ®E P

Eumbel | MName | Status I Duration ! Feason
% 802215331 -» BOS550555 Ananth Krishnan  Incoming Call

Figure 6-6

How Do You Answer a Call from the Call Control Menu?

Click on the Call Control menu and select the Answer option to answer a call.

How Do You Answer a Call Using Hot Key?

Press F3 function key to answer a call.
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6.2.3

6.2.4

6.2.4.1

6.2.4.2

How Do You Answer a Call from Call Control View?

)

Click on the Answer button in the Call Control View to connect the call. The Call
Control View will display the details of the active connected call.

A . O =B
‘%J D8 T E - X~ @' @ @ \nd
Humber | Mame | Status | Diuration | Feazon
il 202 Connected 00:02:28
4| | ®
Ready

[AutoAns [Locked [CallBack [Msa.List [Ho FWD Types [DND [7:45PM 2

Figure 6-7

Other Ways You Can Answer a Call

How do you answer a call using double mouse click ?

Select the incoming call in the call list. Double click on the call to answer.

How do you answer a call using the right click menu?

If there 1s more than one call in the call list, select the call to answer and click the
right mouse button to get the menu. Choose the Answer option to answer the call.




6. Call Control Services

6.3 How Do You Release a Call?

6.3.1

6.3.2

6.3.3

How Do You Release an Active Call from the Call Control
Menu?

Click on the Call Control menu and select the Release option to disconnect an active
call.

How Do You Release an Active Call Using Hot Key?

Press F4 function key to disconnect an active call.

How Do You Release an Active Call from the Call Control View?
()

Click on the Release button in the Call Control View to disconnect an active call.

6.4 How Do You Redial the Last Number Dialed?

6.4.1

You can dial the last dialed number again.

How Do You Redial from the Call Control Menu?

Select the Redial option from the Call Control menu to dial the last number dialed.
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6.5 How Do You Hold/Retrieve a Call?

6.5.1

6.5.2

6.5.3

You can hold your active calls and retrieve them from the call list in the following
ways.

How Do You Hold/Retrieve Calls from the Call Control Menu?

To hold a call, click on the Hold option in the Call Control menu when there is an
active call. The held call will be displayed in the call list.

T ET B R
_N\umber | Mame | Status | Diuration | Feazon
T OnHald 0o:o0:2a
4] | 0
Ready [AutoAns [Locked [CallBack [Msg.List [No FWD Types [DND i0:04 AM 2
Figure 6-8

You can retrieve this call by selecting the held call in the call list and clicking on the
Answer option in the Call Control menu.

How Do You Hold/Retrieve Call Using the Hot Key?

Press F5 function key to hold a call. To retrieve this call, press F3 function key.

How Do You Hold/Retrieve a Call from the Call Control View?
[

Click on the Hold button in the Call Control View to send the active call to OnHold

state in the call list. To retrieve this call, select the call from the call list and click on
the Answer button in Call Control View.
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6. Call Control Services

6.5.4

6.5.4.1

6.5.4.2

Other Ways to Retrieve a Call

Using the right mouse button in the call list

Click the right mouse button on the held call in the call list and select the Answer
option to retrieve the held call.

Using double click in the call list
Double click on the held call in the call list to retrieve a call.

When a call is put in hold state, it will go to the Call List and shows that it is ON
HOLD. If you do not retrieve this call, within the set time, it will come back with
the reason as HOLD RECALL. This is to avoid anyone waiting continuously for you
to answer

6-11




Smart Control Network Version 4.1 User Manual
I

6.6 How Do You Transfer a Call?

You can transfer your active calls to other stations.

6.6.1 How Do You Transfer a Call from the Call Control Menu?

Click on the Transfer option in the Call Control menu. You will get the Transfer
Call dialogue box. Enter the number in the pull-down menu to which the call is to be
transferred.

Transfer Call

—Speed Dial

S
s B~
— KN
EJ%‘?
I M =

-
=]
]
-

*
=
£ ]
™
&
3
b=
=

Figure 6-9

You can also choose the last 10 numbers from the pull-down menu or click on any
of the Speed Dial buttons.

You can transfer your calls in two ways:

-f;%d:; Blind Transfer button
£ 1=z .
J?d:) Consultation Transfer button

Table 6-4
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6.6.1.1

6.6.1.2

6.6.2

6.6.3

How do you Consult and Transfer a Call?

After you enter the number to which the call is to be transferred, click on the
Consultation Transfer button. The active call goes into OnHold pending transfer
mode, while you consult with the station as to whether the station agrees to take the
call. Click on the Release button to transfer the call.

How do you blind transfer a call?

After you enter the number to which the call is to be transferred, click on the Blind
Transfer icon. The active call will get transferred to the station as soon as the
transferred party’s phone rings. You cannot blind transfer a call to an external
number.

Blind Transfer is not supported for external calls. In case you choose Blind
Transfer for an external call, Consultation Transfer will be performed.

How Do You Transfer a Call from Call Control View?

e

i

=5
Click the Transfer button in the Call Control View to transfer a call.

How Do You Transfer a Call Using the Hot Key?

Press F6 function key to transfer an active call.
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6.6.4

6.6.4.1

6.6.4.2

Other Ways of Transferring a Call

How do you transfer a call using Drag and Drop?

Select the contact to which you want to transfer from the Detailed List View. Drag
that number holding the CTRL key and drop into the Call Control View.

How do you transfer a call using the right click menu?
Click on the selected contact in the Detailed List View and right click to get a pop up

menu.

Select the Transfer option to transfer a call.

If the Transferred Party is not in his/her place or does not answer, the call comes
back after a few rings with a call reason as Transfer Recall. This is because the
originally calling party is waiting for the answer.
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6.7 How Do You Conference?

6.7.1

If there is an active call in the Call Control View, you can have another call join you
in a conference in the following ways.

Conferencing from Call Control Menu

Click on the Call Control menu and select the Conference option, when there is an
active connected call. A Conference With dialogue box will appear.

Conference with
I| j ~Speed Dial
1 John |
12 ﬂlzit: IJEF Davwid
l': | = - | '% o 2 avi |
GHI | Jlﬂ_l mml =] |3 Richard |
7 8 | 9 4 Marshall |
PRS TUY WXY
Cancel 5 il |
o] e]
Help |
Figure 6-10

The Call Control View will change as shown.

17 B 6D
TUETDT Bege® @@

Humber | Mame | Status | Diuration | Feason

i 2 ZUNDER Riinging

S On Hold(Conf] 00:00:56

4| | i
Ready [AutoAns [Locked [CallBack [Msg.List [No FwWD Types [DND [I0:07 AM 2

Figure 6-11
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When the other party answers, click on Call Control menu and select Conference
option again. If the other party does not answer, you can release this call and get
connected to the original party using the Release menu/button.

If you want to add another party to the conference, click on the Conference option to
get the Add To Conference dialogue box.

Add to Conference
I j ~Speed Dial
1 John |
12 | ﬂlzil: IJEF | Davwid |
': 5 6 t% Send 2 avi
GHI | Jlﬂ_l mml =] |3 Richard |
7 8 | 9 4 Marshall |
PRS TUY WXY
Cancel 5 il |
o] e]
Help |
Figure 6-12

Enter the number and dial. Once you are connected to the party, press the
Conference button to include the party into conference.

The status of the calls in the call list which are already in conference goes into
OnHold(Conf) till the party is included in the conference. You can add a maximum
of five parties to the conference.

| T BrsC D@
ﬁj D8 T B (X @' FE’ \d

Humber | M ame | Statug | Diuration | Reaszon

i 210 Connected 00:00:32

g 2m ZUNDER On Hold(Conf) 00:02:29

e On Hold(Conf) 00:03:48

1] | i
Ready [AutoAns [Locked [CallBack [Msg.List [No FWD Types [DND [I0:10AM 2

Figure 6-13
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When the other party answers, select Conference option again to add this party to
conference. The status in the call list displays conference. If the party does not agree
to join in the conference, you can release the party and get back with whom you are
already in conference.

) ) &) Ay Y [2)

YRR EBea@ @ i

Murnber | Mame | Statug | Diuration | Fieazon

Conference Call Connected 00:05:02

4yl Corference 00:04:05

o 2o ZUNDER Conference 00:05:16

ez Canference 000708

«| Bl

Ready [AutoAns [Locked [CallBack [Msg List [Ho F&D Types [DND [8:33 AM 7
Figure 6-14

6.7.2  How Do You Conference Using Hot Key?

Press F7 function key to conference, when there is an active call. The Conference
With dialogue box will appear. Enter the number of the party to conference with.

6.7.3  How Do You Conference from Call Control View?

oa
Click on the Conference button to add a party to conference with, when there is an

active call. You will get the Conference With dialogue box. Enter the phone number
of the party who is to be included in the conference.

The connected party will go OnHold pending Conference. After the party agrees to
join the conference, press on the Conference button again to include the party in the
conference. If the party does not agree to join the conference, press on the Release
button in the Call Control View to reconnect to the held party.
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6.7.4

6.7.4.1

6.7.4.2

6.7.5

Other Ways to Conference

How do you conference using right click menu?

Select the contact with whom you want to conference in the Detailed List View and
click the right mouse button. A pop-up will appear. Select the Conference option to
add the party into conference.

How do you conference using Drag and Drop?

Select the contact from the Detailed List View and drag the contact to the Call
Control View to dial the number of the contact. Click the Conference button once
you are connected to the party, to include the party in the conference.

Warning

You can have a maximum of five party conference.

How Do You Drop Parties from Conference?

Select the party to be dropped from Conference. Click the right mouse button and
select the Release option to drop the party from Conference.
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6.8 How Do You Make a New External Call?

To make a new external call on the seized trunk, click on the Call Control menu and
select Make New External Call option. You can dial another external number
without dropping the trunk line.

Make Mew External Call
I| j ~Speed Dial
1 John |
Lz | abc| ok | =
': 5 6 d% Send 2 avi
GHI | JKL | mml =] |3 Richard |
I § | 9 4 Marshall |
PRS TUY WXY
Cancel 5 il |
A R AR
Help |
Figure 6-15

Enter the phone number (do not include the trunk access code ) or select any of the
last 10 numbers you have dialed previously to make an external call. You can also
Speed Dial to any of the five contacts by clicking on them.
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6.9 How Do You Dial Continuously to Make a
Call?

Select the Continuous Dial option from the Call Control menu to dial continuously
to connect to the last number dialed.

Continuous Dial (%]
Retry Count: | 2

Dialing Duration:

o [ ][] ]] 30 Sece

Stop |

Figure 6-16

If you want to redial before the time out occurs, click on the Dial button. Once you
get connected to the internal party the continuous dialing automatically stops; if you
get connected to the external party, you have to click the Stop button to stop
continuous dialing. You can change the redialing duration in the
SetEnvironment—>Time Out option from the Options menu. The default redial
duration is 30 seconds.
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6.10 How Do You Redirect a Incoming call?

For incoming calls at your station, you have got the option of redirecting it to
another station. The REDIRECT option can be selected from Main menu under
[Call Control] option . The call can also be redirected from pop up menu in the
call view.

Whenever you select this option you get a Dialog Box to enter the station number
where the call will be redirected.

ReDirect
~Speed Dial
M r :
1 John |
12 | nznl::l I]EFl David
.r.:‘ : = .% - 2 avi |
GHI| JKL mml =>| (3 Richard |
I § | 9 4 Marshall |
PRS | TUV | WXY
Cancel 5 Ryu |
R [ R
Help
Figure 6-17
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6.11 How Do You Park the Incoming Call?

After answering Trunk Call (External Call) they can be PARKED to another
station using Smart Control.

To PARK a connected trunk call select [Park] menu item from the

[CallControl ]
Park
I j —Speed Dial
1 |
EaENE 2 |
- o0 Send| [T
| | e =2 s |
";5 il W?“' Cancel i—l
o] 2]
Help |
Figure 6-17

Option in the Main menu . When this option is selected a dialog appears to enter
the station number at which the call will be PARKED.
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6.12 How Do You Retrieve a System Held Call?

Click on the Call Control menu and then click on the Pick Up option. The Pick Up
Call dialogue box will appear. You can also get this dialogue box by pressing the
Pickup button in Call Control View.

=

Enter the trunk number(701, 702, etc) and press the System Hold Retrieve
button(First Button).

If that particular trunk is held at some other station you will be connected to the
trunk.

6-23




Smart Control Network Version 4.1 User Manual

6.13 How Do You Pickup a Call?

6.13.1

6.13.1.1

You can answer a call for any other station which receives an incoming call and the
call is not being answered. You can answer that call using the Pick Up option.

How Do You Pickup Using the Call Control Menu?

Click on the Call Control menu and then click on the Pickup option. The Pick Up
Call dialogue box will appear (Figure 6-17). You can either pick up a call from any
station or from any other group.

Pick Up Call
Il j swe 1 ~Fast Station Pickup —
Hold §5" 1 Lee
1 2 3 5T .
ABC | DEF @ 2 Samsung |
iU =
4 | 5 [ | 3 Kim
GHI | JKL | mMno GRP 2
7 | B8 | 9 Pl 4 Ryu
PORS | TUV | WXYZ
. | 0 | # | Cancel | |2 &I
Help
Figure 6-17

How do you pickup a call from another station?

Dial the extension of the station using the Pick Up Call dialogue box or use the pull-
down menu to choose any of the last 10 numbers dialed to pick up a call from a
ringing station. If the station is in your Fast Station Pickup list, select the station and
click the Station Pick Up (Stn P/U) button.
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6.13.1.2

6.13.2

How do you pickup a call from another group?

Dial the group number using the Pick Up Call dialogue box or use the pull-down
menu to choose any of the last 10 group numbers dialed to pick up a call from a
ringing station in another group. Press Group Pick Up (Grp P/U) button.

How Do You Pickup a Call from Call Control View?

Click on the Pickup Button in the Call Control View to pick up a call from a ringing
station or group.
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6.14 How Do You Toggle Between Calls?

In the case of a Consultation Transfer, if the third party does not agree to speak to

the calling party, you can toggle between these two parties.

6.14.1

How Do You Toggle Calls from Call Control Menu?

Click on the Toggle option in the Call Control menu only after the Consultation call

is connected.

2

Teaoa @ @2

Humber | M ame | Statug | Duration | Feaszon

i 202 Connected 00:01:00

T 208 On Transfer Hold - 00:01:19

4] |
Ready [Locked [CallBack [Mzg_List [No P#D Types [DND B:20 PH

Figure 6-18

After selecting the Toggle option, the active call goes into OnHold transfer state and

the held call becomes active in the Call Control View.

¥ ve

Tgeca & B2

Murnber | M ame | Statuz | Diuration | Fieazon

i 208 Connected 00:03:37

i':fj 202 On Transfer Hold  00:03:18

a i
Ready [Locked [CallBack [Mzg.List [No F&D Types [DND 3:22 PH

Figure 6-19
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6.14.2 How Do You Toggle Calls from Call Control View?

ga

Click on the Toggle button in the Call Control View to toggle between calls.

6.15 How Do You Page to a Zone?

D

Click on the Page option in the Call Control menu or the Page button in Call Control
View to get the Page dialogue box. You can page to the zones you have selected
from the dialog box.

a. For DCS

You can page to all individual zones, all external zones or all internal zones.

Page
Pleaze Lift the Handzet befare Paging
| CEREe E e Esternal Zane 1 |
Internal Zaome 1 | External Zone 2 |
Internal Zone 2 | External Sone 3 |
Internal Zone 3 | External Sone 4 |
Internal Zone 4 | &l External Zones |
&l Zones |
4 Ea'ncell Help |
Figure 6-20
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b. For DCS Gateway
You can choose between the Page Zone 0 and the Page Zone 10.

Page E
Please Lift the Handset before Paging
™ R ] e — |
Page Zone 1 | Page Zone B |
Page Zone 2 | Page Zone 7 |
Page Zone 3 | Page Zone 8 |
Page Zone 4 | Page Zone 9 |
Page Zone 10 |

oo |

Figure 6-21
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6.16 How do you Send DTMF(Dual Tone Multi
Freguency) tones?

When a call is connected you can send DTMF tones using the menu option Call
Control/Send DTMF....

The following dialogue box appears.

Send DTMF

1

EREE
ERIEE
1 B

Help |

Figure 6-22
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6.17 How Do You Call Back a Station?

If you dial a station which is busy or which does not answer, you can ask that station

to call you back. The called station rings back to the caller, once the station becomes
idle.

6.17.1 How Do You Call Back from the Call Control Menu?

Select the Call Back option in the Call Control menu.

6.17.2 How Do You Call Back a Station Using Hot Key?

Press F10 function key to request the other station to call you back.

6.17.3 How Do You Call Back a Station from the Tool Bar?

=
Click on the Call Back button in the Station Control Tool Bar to set a station to call
you back.

6.17.4 Other Ways to Call Back a Station

If you call a station which is busy, you can request the station to call back by
choosing the Call Back button in the Station Busy dialogue box (Figure 6-22).
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6.18 How Do You Leave Message for Another

6.18.1

6.18.2

Station?

If you dial a station which is busy or which does not answer, you can leave a
message for this party.

How Do You Leave a Message from the Call Control Menu?

If you want to leave a message on a station, select the Leave Message option in the
Call Control menu. This message will be shown in the Message List dialogue box of
the called station.

How Do You Leave a Message from the Tool Bar?

=

Click on the Leave Message button in the Tool Bar menu to leave a message for the
called station.

6.18.3 Other Ways to Leave a Message

If you call on a station, which is busy, you can leave a message for the station by
choosing the Leave Message button in the Station Busy dialogue box (Figure 6-22).
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6.19 How Do You Camp On to Another Station?

If you dial a station which is busy, you can notify the station that your call is waiting.

6.19.1 How Do You Camp On from the Call Control Menu?

Select the Camp On option from the Call Control menu. The camped-on station
receives a tone indication that your call is waiting. The other station could either
ignore your call or put its active call on hold and answer your camped on call.

6.19.2 Other Ways to Camp On

If you call on a station which is busy, you can notify the station that your call is

waiting by choosing the Camp On button in the Station Busy dialogue box (Figure
6-22).

You can also press F9 to camp on if the called station is not answering.

6.20 How Do You Make an OHVA(Off Hook
Voice Announce)?

If you have called a busy station and you have a voice announcement, select the
OHVA option in the Call Control menu. The busy station will receive the Off Hook
Voice Announce about your waiting call while the station is in conversation.
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6.21 What Happens When You Dial a Busy

Station?

If you call a station which is busy, the Station Busy dialogue box will appear, from

which you can choose the type of operation you want to perform.

Station Busy (%]
Station 204 iz busy
call = Leave
Back = Msg
=
G Z B omn
gcmm %2 Release
Cancel Help
Figure 6-23

call _

Back =

Leave

i Click on Call button, if you want to set a call back on the
busy station

Click on the Leave Message button, if you want to leave a
i message for the busy station

i Click on the Camp on button, if you want to notify the
i busy station about your call is in waiting

i Click on the OHVA button, if you want to intrude on the
| busy station

i Click on the Schedule button, if you want to reschedule this
 call at some other time

1 Click on the Release button, if you want to release the call

Table 6-5
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6.22 What Happens if the Trunk is Busy When You
Dial an External Number?

When you dial an external number and the trunk is busy, the Trunk Busy dialogue
box will be displayed to help you to quickly set the available options such as call
back, redial etc.

Trunk Busy
cal .
Back
e Oy
mm = gelaasal
Cancel Help |
Figure 6-24
call é ' Click on Call Back button, if you want to set a call back
Back + on the trunk or trunk group
! Click on the Redial button, if you want to redial the
Redial C’ﬂ‘
number
r'E?" Conti Click on the Continuous Dial button, if you want to
Dial » continuously dial the number
¢ Click on the Schedule button, if you want to reschedule
this call for some other time
oo o Click on the Release button, if you want to release the
= ¢ call

Table 6-6

A surrounding of Dial Pulse or DTMF signaling ( E1 Trunk), the Trunk Busy
dialogue box will not be displayed to help you.
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6.23 What Happens When You Answer the Trunk

6.24 How

Call Back Call?

If you have set a call back for a trunk when you dialed an external number from
Smart Control Network V4.1, the dial pad will come up and display the number to
be dialed when you answer the trunk call back.

Do You Enter Call Note and Keyword
for a Call?

To make notes related to a call, select the call and click the right mouse button and
select Call Note option. The Call Note dialogue box will be displayed.

Call Hote
Identifier I
MHaote
(.4 I Cancel Help
Figure 6-25

Enter the call note and keyword (Identifier) and press OK button to save the call
note and the keyword.

The call note will be stored along with the call details in the call log. You can
retrieve them later from the call log.
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7. Directory Services

7. Directory Services

This section explains about the Directory Services provided in the Smart Control
Network V4.1 application. Directory Services is maintained in a local database and
a network database. In both of these, you have a Business phone book, an Others
phone book and a Personal phone book.

These are default phone books. The Personal phone book is listed by default in the
Detailed List View when Directory Services is accessed. Under the local database,
you also have a FindResults phone book which holds the result of the last find
operation.

The table below explains the various menus and options associated with Directory

Services:
Menu Options Description
! Print  Prints the selected phone book
File " Fields to Print | Sets up the printing parameters for apage
| Print Preview | Shows preview of a page before printing
""""""""" New Contact | Adds anew contact fo aphone book
Edit Contact | Modifies the selected contact in a phone book
Edit  Delete Contact | Deletes the selected contact from a phone book
' Delete All | Deletes all the contacts from the selected phone
Contacts book
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' New Book

. Adds a phone book

Directory T Connets to the network phone
5 Network Connect book
. PhoneBook ~ F----ooooooiooio_o s
l b + Disconnects from the network
. Disconnect
' ! phone book
"""""""""""""""""  Imports or exports a phone book in Smart Control
' Network V4.1
' Import | Importsan ACT! 2.0 for
(Act 2.0) Windows database
Import | Importsan ACT!4.0for
! (Act 4.0) Windows database
Trmport/ Import """" ' Imports the Smart Control
Export (* sam) Network V4.1 (*.sam) phone
+ book file
Import Imports PS2000 database
(PS2000)
[ Import \ Imports the Microsoft OutLook
! (.mdb) database
| Export ! \ Exports a Smart Control Network
Book V4.1 phone book to a file
. USearches the given string in the phone book
i Search |
: i database
Table 71
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If you click the right mouse button in the Selection View, you will get the following
menu items.

Item Purpose
New Book Adds a new book
Delete Book ! Deletesanewbook
Rename Book | Renames the existing phone book
“Connect | Connects to a network phone book
“Disconnect | Disconnects from a network phone book
"Export : Exports all the contacts from the selected phone book to a file
“Import (*sam) | Adds contacts in a selected phone book froma file
Hide View | Hides the Selection View

Icon/Tree View | Switches between Tree View and Icon View

Table 7-2

If you click the right mouse button in the Detailed List View, you will get the
following menu items.

Item Purpose
New Contact Adds a new contact to a phone book
CEditContact | Modifies the selected contact in a phone book
“Print Contact | Prints the selected contact using the print options you selected
"Delete Contact | Deletes the selected contact from a phone book
"Delete Al | Deletes all the contacts from the selected phone book
“Exportbook | Exports all the contacts from the selected phone book to a file
“Import (*sam) | Adds contacts in a selected phone book froma file
"Dial | Dials the office phone number of the contact
~Schedule Call | Schedules a call to office phone number of the contact
Transfer | . Transfers a call to office phone number of the contact
~Conference | . Adds contact to conference at office phone number
Table 7-3
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Drag and Drop

i Dials the contact at office number if

... | there is no active call.
Drag and Drop a contact from Detailed |

List View to Call Control Vi ! ) .
18t View fo Lafl L-ontrol View  Adds this contact to the conference if

© there is an active call

_________________________________________________________________________________________

Drag and Drop a contact from Detailed : __. .
R : » Dials the extension number of the
List View (Extension Column) to Call

Control View

Drag and Drop a contact from Detailed

contact if there is an active call

List View to Call Control View (by Transfers the active call to this contact
pressing the CTRL key) '
Drag and Drop a contact from Detailed Copies the Selected Contacts to the
List View to Selection View phone book selected

Table 7-4
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7.1

7.2

7.3

7.4

What is a phone Book?

A group of contacts is called a phone book. A phone book can have any number of
contacts. You can create your own phone books and delete them.

What are the Default Phone Books?

The default phone books will always be there in the system. The default phone
books cannot be deleted. They are Business, Others, Personal and FindResults.

What is a Network Phone Book?

The phone book which is not local to your system and exists on the network is the
network phone book.

What is a Contact?

Each entry of a phone book is termed a contact. A contact has a Name, Company,
Office Phone No., Extension, Home No., Mobile Phone No., etc. You can create as
many contacts as you wish. You can also edit and delete these contacts.
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7.5 How Do You Add a New Phone Book?

751

7.5.2

How Do You Add a New Phone Book from the Directory
Menu?

Select the folder in which the phone book is to be created in the Selection View.
Select Local or Network, then click on the Directory menu, and choose New Book
option to create a new book.

In Selection View, depending on whether you are in the Tree View or Icon View,
you will get a new phone book folder or a new phone book icon with a default name
dir(n). You can create as many new phone books as you want.

You cannot have spaces when naming a phone book. Duplicate name is not
allowed.

Other Ways to Add a New Phone Book

You can also click the right mouse button on the folder of the directory in the
Selection View and click on the New Book option.

=@ Smart Cantral Name
=@ Directory
- E-® Local
e FindR e Mew Baook ...
_____ @ Other [DEelete Bonf
@ Peison,|  bename Book
g gc:?iduler Connect ...
altog [iseommest
‘%} B‘B) " Bt bonk
ﬂ Import ... [*.2am)
Humber Hldey.lew
|: lcan Yiew
Figure 7-1
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7.6 How Do You Delete a Phone Book?

7.6.1

7.6.2

How Do You Delete a Phone Book from the Directory Menu?

Select the phone book you want to delete from the selection View.

Click on the Directory menu and choose the Delete Book option. It will ask for
confirmation:

Smart Control

It will delete the Dirll Phone Book
AreYou sure ?

No |

Figure 7-2
Click on Yes, if you are sure, otherwise click No.

The default phone books and Search Results phone book cannot be deleted. If
you are trying to delete a phone book in the Network, you need to have the
access permission to delete it.

If you are in the Tree View and the phone book is deleted successfully, the phone
book folder is removed. If you are in the Icon View, the phone book icon is removed.

Other Ways to Delete a Phone Book

You can also click the right mouse button in the Selection View and then click on
Delete Book option to delete the selected phone book.




Smart Control Network Version 4.1 User Manual

7.7 How Do You Rename a Phone Book?

7.7.1

How Do You Rename a Phone Book from the Directory Menu?

Click on the phone book in the Directory menu and select Rename Book option.
This will allow you to edit the name of the phone book in Selection View. 7.7.2
Alternate Way to Rename a Phone Book

You can also click the right mouse button in Selection View and then click on
Rename Book option to rename the selected phone book.

7.8 How Do You Add a Network Phone Book?

781

How Do You Add a Network Phone Book from the Directory
Menu?

Click on Network PhoneBook option in the Directory menu, then choose Connect
option.

PRIl Call Contral  Station Setup  Optioh
Mew Book...
Delete Book

Bename Book - .

Metwork. PhoneBook  » Connect ...
0] 1
Import/Esport 3 ERanes

Search... "

Figure 7-3
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7.8.2

You will get a pop-up Open dialogue box where you can select the network phone
book you would like to access. If you are already connected to the Smart Control
Network V4.1 network phone book, you have to disconnect it to reconnect to the
other network phone book. Only one network phone book at a time is allowed.

If you have connected to a network phone book while closing the application, the
next time you start your application, the network phone book connection would
be restored..

Network PhoneBook folders are added in Tree View. In Icon View, the Network
button is enabled.

Other Ways to Add a Network Phone Book

When you are under Directory Services, you can also choose the Connect option by
clicking the right mouse button in Selection View to connect to a network
phonebook.
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7.9 How Do You Remove a Network Phone

791

7.9.2

Book?

How Do You Remove a Network Phone Book from the
Directory Menu?

Click on Network PhoneBook in the Directory menu then choose Disconnect option.
The network phone book will be disconnected.

Other Ways to Remove a Network Phone Book

You can also choose the Disconnect option by clicking the right mouse button in
Selection View.
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7.10 How Do You Import/Export a Phone Book?

7.10.1

By importing, you can append an existing phone book to the Smart Control

Network V4.1 directory database; and by exporting, you can export a phone book to
a file.

Click on the Import/Export option in the Directory menu to Import/Export a phone
book.

N Call Control — Station Setup Option MWiew |
Mew Book...
Delete Book
Bename Book. 2

Metwaork PhoneBook  # =

Impart/E xport Impart... [Act 2.0]...
Impart... [Act 4.0]...
Search...
- Import...[* zam]...
~ %% Dusiness

@ FindResuls Impart....[B52000]...
@ Other Impart... [Outlaok)...

@ Personal Evport book

~ 101 iyt |

= R

Figure 74

If you are already using an application such as ACT! 2.0 or ACT! 4.0 for Windows,
PS2000, or Microsoft OutLook as a Contact Manager, you can import the database
into Smart Control Network V4.1 without modifying it.

How Do You Import ACT! 2.0 Database?

The ACT! 2.0 database can be imported into the phone book of your choice by
clicking on Import...(Act 2.0)... option in the Directory menu Import/Export option.
All the contacts in your ACT! 2.0 database will now be added to your selected
phone book.
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When you are importing the database under this option, ensure that you have *.dbf
and *.fpt files in the same directory. Now select *.dbf in the Open dialogue box and
the ACT! 2.0 database file gets field mapped into Smart Control Network V4.1 as
follows:

t Control kV4.1 |
Smart Control Network V + ACT! 2.0 database

database :
Name 1 CONTACT
“Companyname  iINAME T
~Office streetname ADDRI
“officecity  .cmmy
Officezipcode iz
Officestate | STATE
Home street name VALT_ADDRI
“Homecity CALT CITY
"Homezipcode CALT ZIP
Homestate | ' ALT STATE
OfficeNol VPHONE T
“OfficelExtn ¥ EXT
TOfficeNo2 7 VALT PHONE T
“Office2Extn | ALTILEXT
“OtherNo 1 ALT2 PHONE
"FaxNo 1 FAXPHONE
CJobtite YTITLE
“Mobile . CAR PHONE
“Notess NOTES
Table 7-5
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7.10.2

How Do You Import ACT! 4.0 Database?

The ACT! 4.0 database can be imported into the phone book of your choice by
clicking on Import...(Act4.0)... option in the Directory menu Import/Export option.
All the contacts in your ACT! 4.0 database will now be added to your selected
phone book.

Now select *.dbf in the Open dialogue box and the ACT! 4.0 database file gets field
mapped into Smart Control Network V4.1 as follows:

Smart Control Network V4.1

tatabase ACT! 4.0 database
Name ' NAME
“Company name VCOMPANY T
“Office street name | CADDRI T
“Officecity 1 cary T
Officezipcode %7
Office state USTATE T
“Office Country  {COUNTRY T
“Homestreetname . ADDRI T
"Homecity | ALTCITY T
“Homezipcode  ALTzIP T
“Homestate UALTSTATE
“Homecountry ALTCOUNTRY
“OfficeNol "PHONE
OfficelExtn CEXT T
“OfficeNo2 'PHONE2 T
Office2Extn UPHONE2 EXT T
“OtherNo U UPHONE3 T
“OtherExn  IPHONE3_EXT 7
‘DirectNo % ALTPHONE
“HomeNol Y HOME PHONE 7
“Pager 'PAGER
“FaxNo UFAX_PHONE T
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Job title ' TITLE
“Mobile ' MOBILPHONE
Web ' URL
Table 7-6

7.10.3 How Do You Import PS2000 Database ?

The PS2000 database can be imported into the phone book of your choice by
clicking on Import...(PS2000)... option in the Directory menu Import/Export
option. All the contacts in your PS2000 database will now be added to your selected
phone book.

Now select *.mdb in the Open dialogue box and the PS2000 database file gets field
mapped into Smart Control Network V4.1 as follows:

Smart Control Network V4.1 PS2000 database

database .

Name i Name + Iname
Company name | \ Company
DeptName VDepartment T
Office street name 1 Address
TOfficecity 1 cty
“Office zipcode | ZipCode
Office state | State
OfficeNol | cnty-area-number
OfficeNo2 | cnty-area-number
“OtherNo cnty-area-number
DirectNo cnty-areanumber
“HomeNol | cnty-area-number
Jobtitle UTitle T
Tpiewre T T VPiere T

Table 7-7
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7.10.4

7.104.1

7.10.5

How Do You Import *.SAM File ?

The *.sam file can be imported into the phone book of your choice by clicking on
Import...(*.sam)... option in the Directory menu Import/Export option. All the
contacts in your *.sam file will now be added to your selected phone book.

Other ways to import a *.sam file

You can click the right mouse button in the Selection View, when you are under
Directory Services, or click the right mouse button in the Detailed List View to get
the Import...(*.sam)... option.

How Do You Import Outlook Database ?

If you are importing a Microsoft OutLook file, you first have to export the Outlook file in
Microsoft Access format (*.mdb). The fields to be exported are as follows:

Field Name
Name

Company
Department

Business address

Home address

Business phone

Business phone 2
Other phone
Home phone

Home phone 2

Email

Pager

Business fax
Web Page
Job title
Mobile phone
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Once these fields are exported from OutLook in *.mdb format, select the phone
book in Smart Control Network V4.1 that you want to import these fields into and
choose Import...(.mdb)... in the Directory menu Import/Export option. Now select
the *.mdb file from the Open dialogue box. The *.mdb file gets field mapped into
Smart Control Network V4.1 as follows:

Smart Control Network V4.1 OufLook database

database !

Name . Name
“Companyname | Company
Department ! Department
~Office street name | Business address
Home street name | Home Address
OfficeNol | Business phone
OfficeNo2 UBusiness phone2 T
“OtherNo T VOtherphone T
“HomeNol " UHomephone T
"HomeNo2 ~ Homephonel
"Email | Emailaddress
“Pager  Pager
“Faxno ! Business fax
CJobtite 1 Jobtite
“Mobile 1 Mobile phone
WebPage ' WebPage

Table 7-8
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7.10.6 How Do You Export a Phone Book to a File?

You can export a Smart Control Network V4.1 phone book to a file by using the
Export Book option.

Click on the Directory menu Import/Export option and choose Export Book option.
You will get a Save As dialogue box where you can save the selected phone book.
The default file extension is *.SAM. You can also use a file extension name of your
choice.

Warning
If the fields indicate ERROR in the Detailed List View, the Import/Export operation
has failed.

7.10.6.1 Other ways to export a phone book

You can click the right mouse button in the Selection View, when you are under
Directory Services, or click the right mouse button in the Detailed List View to get
the Export Book option.

7.11 How Do You Print Contacts From a Phone
Book?

Edit  Directory

Fields to Print....
Frint Presview

Exit

Figure 7-5
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This prints all the contacts in your phone book. You have the option to select one of
four different types of formats for printing. You can preview the output on screen
before printing it.

To print the contents of a phone book you have selected in the Selection View, click
on the Print option in the File menu. The listing in the printout depends upon the
options you have selected in the Information To Print dialogue box (Figure 7.6). The
output will appear like this:

Profession : Software Engineer, Samsung
Electronics Co., Ltd.

Company Contact

Address : 1001, Prestige Meridian
First No : 82-2-3469 2504-extn-201
Second No

Other No

Direct No

Internal No : 201

Home Contact

Address : 826-30, Samsung-Dong, Kangnam-Ku
First No

Second No

Farm No

GuestHouse No

Other Contact Nos

Fax : 82-2-3469 2500
Mobile

Pager

Email : socket@samsung.co.kr
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7111

7112

How Do You Set Up Fields for Printing?

You can select the individual items of information to be printed by selecting options
from the Information To Print dialogue box.

Information To Print [ X]
¥ Profession
‘,-"1
¥ Home Info JLIES

V¥ Caompany Info

[+ Other Contact

¥ Select Al

Figure 7-6

Click the Fields to Print option on the File menu. The Information To Print dialogue
box will appear with five checkbox options. Select the option or options for which
you want a print out.

For example, if you want a printout of a phone book listing only the professional
details, check against the Profession checkbox and deselect the rest of the
checkboxes.

If Select All option is checked, all the other options get checked. Figure 7-6 shows

all the options checked, so in this case you would get a printout of all the details in
the phone book you have selected in the Selection View.

How Do You Preview the Printout?

You can preview the print output on the screen by clicking on Print Preview option
in the File menu.
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7.12 How Do You Add a New Contact to a Phone
Book?

Directory  Call T

Mew Contact...
Edit Contact...

Delete Contact
Delete Al

Figure 7-7

7.12.1 How Do You Add a New Contact Using the Edit Menu?

Click the New Contact option in the Edit menu to add a new contact to the phone
book which is selected in Selection View.

On clicking this option, the Add Record dialogue box will appear into which
relevant information is to be entered.

Add Record

Personal Info | Contact Info |

Picture Name
k. Am

|
Lompany Mame I
JobTitle [ =]
Department I

I Home Addlessj

Browse ... | Edit Address ... I

Note | Email | |

|+§§t I | “DK I |xCance]| Help |

Figure 7-8
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Personal Info page

Enter the data for the fields Name, Company Name, Job Title etc. For example, in
the Job Title field, you have a pull-down menu containing job titles; you can select
the job title from the menu or enter your own job title.

For the Edit Address field, you can select the type of address from the address pull-
down menu and click on the Edit Address button to enter the details.

Sue Smith

Personal Infa | Cortact Info I

Ficture

MHame IS ue Smith

Company Mame ISamsung Electronics Co., Lid.
JobTitle IDperator j
Department IHeIp Desk

|Dffice Address 7 [SamsunaDona 14417,
Seoul, 135090
Edit Address ... Korea.

HNote | Email IS ueSmith{@samsung. co ke

|-Prev I |+Nex‘t| |VUK I |xCance]| Help |

Figure 7-9

The Note button is used to launch Notepad with the <namecompanyname>.txt file,
so you can enter any notes for this contact. The file will be stored in the
SmartControl\ContactNotes directory. Because it uses the name and company name
you entered as the file name, be precise in what text you enter in these fields.

The Email button is for launching the registered default email application.

To insert a bitmap image (picture) of the contact, click the Browse button on the
Personal Info page of the dialogue box and select the bitmap file.

To enter phone numbers, click on the Contact Info tab.
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Contact Info page:

John
Persanal Infa Contact Infa |
Crity-rea-Mumber

ez @ el
[Homet 7] |a2-2 &
Fan Mo, |a2-2-
Paget No. | &
Mobile No. | &
Home Pags [ftg: s ﬂI

|-Prev I |+Nex‘t| |VUK I |xCance]| Help |

Figure 7-10

Pull-down menus are provided to enter different Office/Home phone numbers. You
select the Office phone type from the Office phone pull-down menu to enter the
office phone numbers and the extension phone number in the Extn field.

The phone number field starts with Country code-Area code (in this example, 91-
080). Smart Control Network V4.1 picks up the country code and area code from
the Telephony dialing properties of your system.

If you click on the phone icons next to the fields in this dialogue box, you
automatically dial the number entered in the field.

Warning
Smart Control does not accept ‘-’ within a phone number except the ‘- between
country code and area code. The format is CNTY-AREA-PhoneNumber

Click the OK button to add a contact, or the Cancel button if you decide not to add
this contact. If you wish to add another contact, click the Add Next button.
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7.12.2

The entered contact gets appended to the database file and a blank Add Record
dialogue box appears with the Personal Info tab selected.

Whichever Office No. or Home No. is selected, it will appear in the respective
fields in the Detailed List View

Other Ways To Add a New Contact

You can also add a new contact by clicking the right mouse button in the Detailed
List View.

7.13 How Do You Edit a Contact?

7.13.1

How Do You Edit a Contact Using Edit Menu?

Select the phone book contact in the Detailed List View and click on the Edit
Contact option. An Update Record dialogue box will appear where you can modify
the entries for the desired contact.

Sue Smith

Personal Infa | Cortact Info I

Ficture

MHame IS ue Smith

Company Mame ISamsung Electronics Co., Lid.
JobTitle IDperator j
Department IHeIp Desk

|Dffice Address 7 [SamsunaDona 14417,
Seoul, 135090
Edit Address ... Korea.

Nate | Email % ISueSmith@samsung.co.kl

|-Prev I |+Nex‘t| |VUK I |xCance]| Help |

Figure 7-11
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7.13.2

Click on the Prev or Next button to edit the previous or next record in the selected
phone book. If you click on Prev or Next button after modifying a contact, those
modifications will be saved automatically.

Other Ways to Edit a Contact

You can also edit an existing contact by:

« Clicking the right mouse button after selecting the phone book contact in the
Detailed List View and then clicking on Edit Contact option.
« Double clicking on the selected contact in the Detailed List View.

The Edit option is enabled in the Detailed List View only when a contact.has been
selected

7.14 How Do You Delete Contacts?

7141

7.14.2

How Do You Delete Contacts from Edit Menu?

Select the phone book contacts in the Detailed List View and click the Delete
Contact option in the Edit menu to delete the selected contacts from the phone book.

Other Ways to Delete Contacts

You can also delete a selected phone book contact from the Detailed List View by
clicking the right mouse button and then selecting the Delete Contact option.
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7.15 How Do You Delete All Contacts?

7.15.1 How Do You Delete All Contacts from the Edit Menu?

You can delete all contacts in a selected phone book by clicking the Delete All
Contacts option in the Edit menu.

7.15.2 Other Ways to Delete All Contacts

You can also delete all records in the selected phone book from the Detailed List
View by clicking the right mouse button and then clicking on the Delete All option.
It will ask for confirmation.

Click on Yes, if you are sure, otherwise click on No.
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7.16 How Do You Search for a Particular Contact?

You can search for a contact in the Local and Network phone book databases. The
search results appear in the FindResults phone book. Any changes you then make to
the search results will be reflected in the original phone book database containing
the contact.

Select the Search option in the Directory menu and enter the text you want to search
for in the Find Text in Phone Book dialogue box. Click OK. The contacts which
match the text entered will be added to the FindResults phone book (any contacts
previously in the FindResults phone book will be deleted).

Find Text in Phone Book

Fird what ||
|¢DK I |xCancel| Help |

Figure 7-12
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7.16.1 Find Results After Using the Search Option

Click the right mouse button on the selected contact in the Detailed List View. A
pop up will appear with which you can perform various operations on the searched
results.

£ Smart Control Network ¥4.1 - Administrator - 201
File Edit Directory Call Contral  Station Setup  Option  Yiew Help
BN I =)
I o
u
@ = |V =
E|@ Smart Cortral Compar
= @ Diecloy i oy o Co L |
. B Local [Hev Eantact
; @ Business Edit Contact
A FindResults Print Contact...
: - Other Hide Contact
i Personal Hide Al
@ Schedulsr —
- Calllog Ezport Results
Impart(Fsam]
Dial
1] Schedule call _'I
Tinatistern
e I ™ 2
‘%J #j} '& M = oo @ (Sorferetine )
Ready [AutoAns [Locked [CallBack [Msg.List Mo P&D Types 4
Figure 7-13

You can do the following.

Click on Edit Contact option to get details of the contact in the Update Record
dialogue box. Here, you can update the contacts in the FindResults phone book. The
changes made here will be reflected in the original phone book.

Click on Hide Contact option and the selected contact(s) will be hidden. The
contact(s) will be deleted only from the FindResult phone book.

Click on Hide All option and all the contacts will be hidden. The contacts will be
deleted only from the FindResults phone book.
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Click on Export Results option. An Open dialogue box will appear. Enter a filename
under which those contacts that have been displayed are to be kept. Those contacts
can later be imported using the Import option.

Click on Dial option and it will dial the number of the selected contact. The number
will be selected based on the current cursor position.

Click on Schedule Call option. An Add Schedule dialogue box will appear where
you can schedule a call. The number will be selected based on the current cursor
position.

If there is a connected call, click on Transfer option, so that the call will be
transferred to the number of the selected contact. The number will be selected based
on the current cursor position.

If there is an active call in the Call Control View, click on Conference option, so that
the number of the selected contact will be put into conference. The number will be
selected based on the current cursor position.

You can also drag and drop from Office no., Home No., Pager or Mobile to
make a call. By default, the office phone number is dialed.

The system also supports Drag and Drop for copying, dialing, transferring a call and
conferencing.
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7.16.2 Change in File Menu After Searching

The File menu now supports the printing of contacts found after searching.

7.16.3 Change in Edit Menu After Searching

The following features will now be added to the Edit menu after selecting any of the
searched results:

« Hide Contact option—the selected contacts will be deleted from the FindResults
phone book.

« Hide All option—all the contacts in the FindResults phone book will be deleted.
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7.17 Directory Services in Detailed List View

&!Small Control Network ¥4.1 - Administrator - 201

File Edit Directory Call Control  Station Setup  Option Wiew  Help

Br-griy RN
@ &N a SR

Mame | Company | Office Phane | Esth | Home Phane | abile | Fagel

87426 82-3489-25(

Samsung Electonics Co.,Ltd.

e Eantact
Edit Contact
Frint Contact...
Hide Caontact
Hide &l

Export Results:

Impart(Eeam]

Dial
g I Schedule call _'I
Tiransfer

'&'J Rz’ 48- ‘j\? :‘a_. nﬂn @ @ @ Tﬂ Cotfereree

Ready AutoAns |Locked [CallBack |M=sg.List [Mo PwD Types DMD (43 PI
7

Figure 7-14

This displays the contents of the selected phone book in the Detailed List View. The
fields listed are Name, Company, Office Phone, Extn., Home Phone and Mobile.

7.17.1 How Do You Sort Contacts?

You can sort the list according to Name, Company, or Mobile field in ascending or
descending order by clicking on the respective column headers.

When you click on the column header, it will sort in ascending order on that field. If
you want to sort it in descending order, click the header again.
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7.17.2 How Do You Add a Contact?

Click the right mouse button in the Detailed List View and choose New Contact
option to add a new contact in your phone book.

7.17.3 How Do You Edit a Contact?

Click the right mouse button in the Detailed List View and choose Edit Contact
option to modify an existing contact in your phone book.

7.17.4 How Do You Delete a Contact?

Click the right mouse button in the Detailed List View and choose Delete Contact
option to delete the selected contact from the phone book.

7.18 How Do You Delete All Contacts from Your
Phone Book?

Click the right mouse button in the Detailed List View and choose Delete All option
to delete all the contacts from the phone book.

Once you choose the Delete All option, it will ask for confirmation.

Click on Yes, if you are sure, otherwise click No.
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7.19 How Do You Dial a Contact?

Select the contact from the phone book in the Detailed List View and click the right
mouse button.

Choose the Dial option to dial. Dial option dials the number of the selected contact.
The number will be selected based on the current cursor position.

7.20 How Do You Schedule a Call to a Contact?

Select the contact from the phone book in the Detailed List View and click the right
mouse button in the Detailed List View.

Choose the Schedule Call option to schedule a call to the number of the contact. The
number will be selected based on the current cursor position.

7.21 How Do You Transfer a Call to a Contact?

Select the contact from the phone book in the Detailed List View and click the right
mouse button in the Detailed List View. If you have an active connected call in the
Call Control View, you can transfer this call to the number of the selected contact by
clicking on Transfer option.

The number will be selected based on the current cursor position.

7-32




7. Directory Services

7.22 How Do You Add a Contact to a
Conference?

Select the contact from the phone book in the Detailed List View and click the right
mouse button in the Detailed List View.

If you have an active call in the Call Control View, you can include this contact in
the ongoing conversation by clicking the Conference option.

This dials the number of the contact. The number will be selected based on the
current cursor position.

7.23 How Do You Print a Single Contact?

Click the right mouse button in the Detailed List View after selecting a contact, then
choose Print a Contact.

The selected contact will be printed with the options set in Page Setup.
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8. Drag & Drop Services

You can click the mouse button on a contact in the Detailed List View and drag it
across Selection View or Call Control View to perform various functions such as
dialing, transferring a call and conferencing. This operation is called Drag and Drop.

Item : Purpose

i Copies the selected contacts to the phone
' book selected

_________________________________________________________________________________________

i If there is no connected call, it dials. If there

Dragging to the Selection View

Dragging to the Call Control View is a connected call, a conference is
 established with this contact

Dragging Extension to Call i Dials the extension number if the call is
Control View i connected

Dragging Home number to Call

Control View
" Dragging Mobile number to Call ¢ .. . .
ragglng. obtie umberfota ' Dials the mobile number
Control View '
" Dragging Pager num bertoCall .
TAESIng . agermtmbertota 1 Dials the Pager number
Control View :

Table 8-1
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8.1 Drag

8.2 Drag

and Drop - How Do You Copy Contacts
Across Phone Books?

Select the contact to be copied in the Detailed List View. Drag it into the Selection
View and drop it into the phone book you wish to copy to. The cursor will show

Copy.

If you drag the mouse cursor from Detailed List View to Call Control View, the
cursor shows Dial. If you drag the mouse cursor from Detailed List View to
Selection View, the cursor shows Copy.

and Drop - How Do You Dial?

Select the phone book contact in the Detailed List View. Drag and drop into the Call
Control View to dial a phone number.

If you drag from the Name, Company, Office Phone or Extn and drop in the Call
Control View, by default the office phone number is dialed. If you drag from the
Home Phone column and drop into the Call Control View, the home phone number
is dialed.

If you drag from the Mobile Phone column and drop into the Call Control View, the
Mobile Phone number is dialed.
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8.3 Drag and Drop - How Do You Transfer a
Call?

When there is an active call, press the CTRL key and drag the contact from the
phone book in the Detailed List View and drop into the Call Control View to
transfer the call to the selected contact.

8.4 Drag and Drop - How Do You Conference a
Call?

When there is an active call, drag the contact from the phone book in the Detailed
List View and drop into the Call Control View to add the contact to conference.

8.5 Drag and Drop - How Do You Dial an
Extension?

When there is an active call, drag the extension from the phone book in the Detailed
List View and drop into the Call Control View to dial the extension number.
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9. Scheduler Services

This chapter tells you about the Scheduler Services provided in Smart Control
Network V4.1. You can schedule outgoing calls, set/reset different types of call
forwarding, set/reset DND (Do Not Disturb) and set/reset Vacant Station Messages.

9.1 What is a Schedule?

It is a service which is triggered at a set date and time.

Scheduler Services can be viewed both in Tree view or Icon view in Selection View.
When you click on Scheduler, it displays the contents of All Scheduled records in
the Detailed List View by default.

The Detailed List View displays the scheduled function, details, frequency of the
scheduled function and the time during which the scheduled function is active.

You can view different Schedule functions in the Detailed List View by selecting
them in Selection View.
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For example, when Outgoing Call is selected in Selection View, you can view the
scheduled outgoing calls in Detailed List View.

Item Purpose
. . Shows the function set for a scheduled item such as DND,
Function : . .
» outgoing call, forwarding, etc.,
' Detaﬂ """""""" ' Shows the details of the scheduled item such as destination
' number, vacant station message number, etc.
% Shows the frequency set for the scheduled item: once, daily,
Frequency .
» weekly or yearly.
"Time ~: Shows the time set for the scheduled item
- State """""""" Shows the state of the schedule item such as completed,
' scheduled, rescheduled, etc.
"Note ~: Shows the message entered in the schedule note
“New Schedule | Addsanew schedule T
Edit Schedule | Modifies aschedule T
Delete Schedule | Deletes aschedule 7
Delete Al ' Deletes all the selected schedules

Table 9-1
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9.2 How Do You Add a New Schedule?

9.2.1 How Do You Add a New Schedule from Edit Menu?

Click on Edit menu and select New Schedule option. You will see the Add Schedule
dialogue box.

Add Schedule (%]

Schedule I F[equenc:_l,ll
¥ Remind Schedule Mate I

— To Scheduls

EontaciFopum
Destination I

© Cal Forward
Tupe of calle I.-’-‘«II Callz 'l

© 0wt Gaing Call
Sound File I

£ Station Lock B I Play |

| MJK I |xCancell H=lp |
Figure 9-1

You can choose one of the items you want to schedule at any one time. Depending
upon the item selected, different controls will be enabled or disabled.
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9.2.1.1 How do you schedule a Do Not Disturb?

If you wish not to be disturbed by incoming calls for a selected time, or on some
day:

Click on Edit menu and select New Schedule option to get the Add Schedule
dialogue box.

Add Schedule (%]

Schedule I F[equenc:_l,ll
V¥ Remind Schedule MNate |

~ Ta Scheduls

Cortact Bopup 2
Destination I

€ Call Forward
Tupe of calls IAII Call= 'I

€ Dut Gaing Call
Sound File I

- .

Station Lock. i I Play |
| VDK | |xCance]| Help |
Figure 9-2

Click on Do Not Disturb option. You can also enter a comment in the Schedule
Note field, if required. Now click on the Frequency tab and enter the Date, Time and
Frequency for the DND option to be active (see Section 9.3 for details).
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9.2.1.2

How do you schedule a Call Forward?
If you wish to forward your calls to some other station at a selected time or on some

day:

Click on Edit menu and select New Schedule option to get the Add Schedule
dialogue box.

Add Schedule
Schedule | Frequencyl
™ Remind  SchedulsNote |
— Tao Scheduls  Details
EontaciFomn
¢ Do Mat Disturb
Destination |21
& Call Forward
Tuvpe of callz IAII Callz 'l
€ Qut Gaing Call
Sound File I
- .
Station Lock Branrs I o |
[ | [2€cmal _ e |
Figure 9-3

Click on Call Forward option. Select the type of calls to be forwarded in the Type of
calls pull-down menu. In the Destination field, enter the phone number to which the
call is to be forwarded. You can also enter a comment in the Schedule Note field, if

required.

Now click on the Frequency tab and enter the Date, Time and Frequency for Call
Forward to be active (see section 9.3 for details).
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9.2.1.3 How do you schedule a call?

If you wish to make a call to some number at a selected time or on some day:

Click on Edit menu and select New Schedule option to get the Add Schedule
dialogue box.

Add Schedule

Schedule | Frequency I

™ Remind  SchedulsNote |
 ToSchedule

¢ Do Mat Disturb

Destination |21

Tuvpe of callz IAII Callz e l

™ Call Forward

& 0yt Going Call

Sound File I

Brawse I By |

|¢DK I |xCancel| Help |

Figure 94

€ Station Lock.

Click on Out Going Call option. Enter the phone number in the Destination field.
You can enter any comments in the Schedule Note field.

The Schedule Note will be shown as Call Note when the call is made, for example:
“Birthday Greeting”. Now click on the Frequency tab and enter the Date, Time and
Frequency for Out Going Call to be active (see Section 9.3 for details).

If a contact pop up is needed when the outgoing call is being made, select the
contact pop up. It will pop up the property sheet if the contact information is
available in the directory database.
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9.2.14 How do you schedule a Do Not Disturb?

If you wish to lock your phone at a selected time or on some day:

Click on Edit menu and select New Schedule option to get the Add Schedule
dialogue box.

Add Schedule

Scheduls | Frequency I

W Bemind Schedule Mate I
 To Scheduls

Do Mot Distuh

¢ Call Forward

Pazzword I
¢ Dut Gaing Call -
Sound File I

Browse I Flay |
|¢DK I |xCancell Help |

Figure 9-5

Click on Station Lock option. Enter the Password. You can also enter a comment in
the Schedule Note field, if required.

Now click on the Frequency tab and enter the Date, Time and Frequency for Call
Forward to be active (see section 9.3 for details).

9.2.2  Other Ways to Schedule a Call

Select a contact in the Detailed List View. Click the right mouse button on the
contact and choose the Schedule option to schedule a call to this contact.
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9.3 Frequency Option in Scheduler

This is used to set a time, date and frequency for execution of the scheduled item.

Add Schedule

Gohedule  Frequency |

Day I\A-"ed YI Frequency IDnce YI

— dd/mmdp

Eram WW::II IW 36 a.m::ll
— dd/mmdp

Ia FW::II IW a2 a.m::ll

|¢DK I |xCancel| Help |

Figure 9-6

You can choose any one option from the Frequency pull-down menu. Depending on
the type of frequency selected, certain fields may be enabled or disabled. These
fields can be used to enter the day, date and time.

9.3.1 How Do You Schedule an Item Once?

If you select Once option, the scheduled services will be executed only once for the
date and time you enter.

9.3.2  How Do You Schedule an Item Daily?

If you select Daily option, the scheduled services will be executed every day at the
time you enter.
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9.3.3  How Do You Schedule an Item Weekly?

If you select Weekly option, the scheduled services will be executed weekly on the
day of the week and at the time you enter. You can select the day of the week from
the Day pull-down menu.

9.34  How Do You Schedule an Item Yearly?

If you select Yearly option, the scheduled services will be executed yearly on the
day of the year and at the time you enter.

9.4 Reminder Option in Scheduler

If you wish to be reminded before a scheduled item is activated, check the Reminder
option box.

At the scheduled time a dialogue box will pop up to ask for confirmation of
continuation of the schedule. If a wave file is configured to be played for the
Reminder, it will be played along with it.

If you click on “No” the scheduled item is not activated. The dialogue box will
remain for 10 seconds after which it will be assumed that the answer to the
confirmation is “No” and the scheduled item is not activated.
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9.5 How Do You Edit a Schedule?

95.1

9.5.2

How Do You Edit a Schedule from Edit Menu?

If you have any change in plans and you have scheduled a service, you can modify
the schedule using the Edit Schedule option from the Edit menu.

Other Ways to Edit a Schedule

You can edit a selected schedule in the Detailed List View by clicking the right
mouse button and then clicking on Edit Schedule.

9.6 How Do You Delete Schedules?

9.6.1

9.6.2

How Do You Delete Schedules from Edit Menu?

Select the scheduled items to be deleted from the Detailed List View, and click on
Delete Schedule in the Edit menu.

Other Ways to Delete a Schedule

You can delete a selected schedule in the Detailed List View by clicking the right
mouse button and then clicking on Delete Schedule.
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9.7 How Do You Delete All Schedules?

If you want to delete all the scheduled items which are currently visible in Detailed
List View, click on Delete All option in the Edit menu. A Smart Control Network
V4.1 dialogue box will prompt for confirmation.

Smart Control [ ]

& Delete all the selected schedules?
Ho |

Figure 9-7

Click on Yes if you are sure, otherwise click on No.

Warning

If you click on Delete All, all the scheduled items which are currently selected in
Selection View will get deleted (e.g. if DND folder/icon is selected in Selection
View then all the DND schedules will be deleted).

9.8 How Do You Sort Different Scheduled Items?

To sort the schedules in Detail List View, click on the header for that particular
column. For example, if you click on Function, it will sort all the scheduled items
according to function (DND, Forwarding, etc.) Sorting is available on Function,
Frequency, Time and State.
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10. Call Log Services

This chapter tells you about the Call Log Services provided in Smart Control
Network V4.1.

These services maintain the records of all incoming and outgoing calls. You can
view the logs by selecting the log type in the Selection View.

Contents of All will be displayed in the Detailed List View in descending date order
by default.

Item ! Purpose

All To display both incoming and outgoing call details

_____________________ g

Incoming Calls i To display only incoming call details

Outgoing Calls : To display only outgoing call details

Table 101
Fields in the Detailed List View.
Item Purpose

Name Displays the name of the caller/called party

From/To Displays number of the caller/called party

Date Displays the date when the call was made

Duration Displays the duration of the call

Call Note Displays tl}(—:‘ call note entry made after the call in the Call
i Control View
! 'ﬁ.’ ''''''''''''''''''''''''''''''''' T IT T AT 7T

Identifier : isplays tl.le keyword entry made after the call in the Call
i Control View

10-1




Smart Control Network Version 4.1 User Manual
I

Displays the status of the call, such as:

RingBack—when you have called a station and the party
does not answer

Status Busy—when you have called a busy station
i Connected—connected call
Unanswered—when there was a call to your station and you
 did not answer
"DNIS | Display the DNIS number of the call ifany
Table 10-2

10.1 How Do You View Call Logs?

10.1.1 How Do You View All Call Logs?

If you select the All icon in the Selection View, you will get the logs for both
incoming and outgoing calls on your station displayed in the Detailed List View.

10.1.2 How Do You View Incoming Call Log?

If you select Incoming Calls in the Selection View, all the incoming call log records
will be displayed in the Detailed List View.

10.1.3 How Do You View Outgoing Call Log?

If you select Outgoing Calls in the Selection View, all the outgoing call log records
will be displayed in the Detailed List View.
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10.2 How Do You Sort Logs?

To sort the logs in Detail List View, click on the header for that particular column.
For example, if you click on Name, it will sort either in ascending or descending
order of the name of the caller/called party depending on which order they are
currently in.

Sorting is available on Name, Callerld, Date, Duration, Status and DNIS.

10.3 How Do You Print a Call Log?

10.3.1 How Do You Print a Call Log from File Menu?

Print...
Print Setup...
Prirt Presview:

Figure 10-1

Select the Print option from the File menu when you are in the Call Log Services to
print all the call logs. The options are:

o Print - To print the Call Logs

o Print Setup - To select the print format
o Print Preview - To preview the print
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10.3.2 How Do You Set Up Difterent Types of Call Log Print Formats?

If you click the Print Setup option, the Select Format to Print dialogue box appears,
from which the format for printing can be selected.

Select Format To Print

Frint format
’7 © Detail View (o]

=

MJK | anncell Help |

Figure 10-2

The printout in Detail View will appear as shown below:

Name : Basheeruddin
Number : 201

Date : - - -
Duration : 00:00:00
Call Note : - - -
Status : Ring Back

Name : - - -

Number : 203

Date : - - -
Duration : 00:00:00
Call Note : - - -

Status : Ring Back

10.3.3 How Do You Preview the Print Output for a Call Log?

You can preview the printout on-screen by clicking the Print Preview option.
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10.4 How Do You Delete Logs?

Delete Log
Delete Al

Save Mote
Find...

Figure 10-3

Select the Delete Log option from the Edit menu. The selected call log records will
be deleted.

10.5 How Do You Delete All Logs?

Click the Delete All option.

Warning

If you click on Delete All option, all the selected logs in Selection View will be
deleted. For example, if in Selection View the Incoming Calls folder/icon is
selected, then Delete All option will delete all the incoming call log records.

Delete
Delete Al

Edit Mote
Save Mote
Print Log
Redial

Figure 104
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10.6 How Do You Save Note of a Call Log?

Right click on selected call log and select the Save Note option. A File Save
dialogue box will appear. Specify the file name and store the note in the *.txt file.

10.7 How Do You Find a Log with Given
|dentifier?

Select the Find option from the Edit menu. A dialogue box will appear for the
Identifier to be highlighted. Click on OK button. If a call log with the given
Identifier is available it will be highlighted in the Detailed List View; if not, a
message box will appear saying that no log was found with the given Identifier.

10.8 How Do You Print a Single Log?

Right click on the call log in Detailed List View and select Print Log. The log will
be printed in detailed format.
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10.9 How Do You Edit the Identifier and Call

Note?

Right click on the call log in Detailed List View and select Edit Note. A property
sheet will appear with the call log details and the Identifier and Call Note fields to be
edited. Make your changes and click on OK to save the new details in the call log
database.

10.10 How Do You Redial from Call Log List View?

10.11DNIS

Right click on the call log in Detailed List View and select Redial. This will dial the
number from the call log list.

The phone number in incoming call logs is in CNTY-AREA-NUMBER format
whereas the phone number in outgoing call logs is formatted as the digits were
dialed.

Field in the Call Log

This field is introduced in call log records to denote the DNIS number, if any, in the
call. This number is shown as a separate field in the Detailed List View. For printing
purposes and for the detailed property sheet, this number is shown as part of the
From/To field itself. It appears as NUMBER - DNIS.
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11. DDE(Dynamic Data Exchange) Support
In Smart Control Network V4.1

Dynamic data exchange (DDE) is a form of communication (inter process) that uses
shared memory to exchange data between applications.

Applications can use DDE for one-time data transfers and for ongoing exchanges in
which the applications send updates to one another as new data becomes available.

Client and Server Interaction

DDE always takes place between a client application (the ‘client’) and a server
application (the ‘server’). The client initiates the exchange by establishing a
conversation with the server so that transactions can be sent to the server. (A
transaction is a request for data or services.)

The server responds to these transactions by providing data or services to the client.
A server can have many clients at the same time, and a client can request data from
multiple servers.

Also, an application can be both a client and a server. A client terminates a
conversation when it no longer needs a server’s data or services. For example, a
graphics application might contain a bar graph that represents a corporation’s half -
yearly profits, and the data for the bar graph might be contained in a spreadsheet
application.

To obtain the latest profit figures, the graphics application (client) establishes a
conversation with the spreadsheet application (server). The graphics application
then sends a transaction to the spreadsheet application, requesting the latest profit
figures.
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11.1 Smart Control Network V4.1 Application as
DDE Client

Smart Control Network V4.1 can act as a DDE client to start a conversation with
Personal Information Manager (PIM) applications such as Symantec ACT! 2.0,
GoldMine for Windows, SuperOffice etc. These applications act as DDE servers.

You can Enable DDE in Smart Control Network V4.1 by selecting Options
—->DDE....

Call Motification tethod...

Phane Lines...
Set Environment

Figure 11-1

When DDE is enabled in Smart Control Network V4.1, then for any incoming call a
command is sent to your selected PIM application (which acts like a DDE server) to
search for the caller’s contact record based on the incoming callerID or DNIS
(Dialed Number Identification Services).

You have the option to specify the search based on call type, such as Internal Call

and/or External Call, as well as on CallerID or DNIS. The dialogue box that appears
when you select Set Environment --> DDE. . .from the Option menu is shown below.

11-2
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Select the DDE Server (%]
Enable DDE Search

W For Incoming [ntemal Calls

@ szing Caller's 1D
 Using DMIS

— DDE Program

Program: I Maone

j Tiesk |

Path: IN one Selected
SMNETNECMD

Erawze,.,

Carmmand: ISN ETHECMD

j Farmat...

- Databasze File

Fath: IN ahe

il

Erowse...

o]

Cancel Help |

Figure 11-2

In the DDE Program combo (dropdown list) box the following PIM applications are

supported:

¢ Symantec ACT! 2.0,

« GoldMine for Windows,
o SuperOffice4.0,

o Maximizer for Windows.

For these applications you need only select the PIM application name, the
application’s EXE file path and the database file to be opened for finding the contact
record. The DDE initialisation based on the Services Name and Topic Name is
handled by Smart Control Network V4.1.
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11.1.1 Smart Control Network V4.1 as DDE Client to Symantec ACT!
2.0

If you have enabled DDE and selected Symantec ACT! 2.0 as your PIM, you need
to enter the path for the ACTWIN2.EXE file. Choose your ACT file (*.DBF)
containing the contact records. (If you are not sure about the path of the EXE file,
run the file by pressing the TEST button.)

When you click on OK on the Select the DDE Server dialogue box, DDE is
initialized with ACT! as the DDE server.

& ACT! - [MyFirst]

File Edit Schedule Phone “Wite RBeport Lookup Yiew ‘Window Help

ﬁnl@ls%l ElEEENEER EEEE

Company | |5 amsung | Address | I:
= Cantact ||Syed | |pres
o1 | Phens /8138550555 | Eat || | I

Fa || e st ] oy |ban

Lookup: p K.
Eiveryone Title | | | State | E
Dear |[Syed | ZIPCode |[560
Group: Cal H | | | E|
eeto | ]| F ]
— T Il I el
Figure 11-3
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Guidelines for using Symantec ACT!

1.

To view the caller’s record in ACT!, you must set your current screen in ACT! to
“Contact Screen One” (see help on contact screen in ACT! for further
information). An example “Contact Screen One” for ACT! is shown in Figure
11-3..

Even though the caller’s contact record is found, ACT! does not pop up. It is
better to have ACT! maximized in the background.

If you have entered a password for database access, you need to run ACT!
prior to the initialiation of DDE using Smart Control.

Format of phone numbers in ACT!:
If your contact record’s number is nnnnnnn (same area), you need to have this
in ACT! as nnn-nnn-n for popup to occur.

If your contact record’s number is cc-aa-nnnnnnn (different country), you need
to have this in ACT! as cca-ann-nnnnn for popup to occur.

If your contact record’s number is nnnn (mostly internal) then you need to
have this in ACT! as nnn-n.
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11.1.2  Smart Control Network V4.1 as DDE client to GOLDMINE

If you have Enabled DDE and selected GOLDMINE as your Personal Information
Manager(PIM) then you need to enter proper path of the GOLDMINE
EXE(i.e.gm4.EXE). Choose your GOLDMINE CONTACT file containing the
contact records. If you are not sure about the path of the EXE, run the entered EXE
by pressing the TEST button.

When you click O.K button to “Select the DDE Server” dialog. A dialog requiring
user to enter “Login & Password” for GOLDMINE appears.

DDE Server Information

GOLOMINE

U sername: ||
Pazzword: I

Figure 114

Enter your username and password, if any. When entered correctly, DDE is
initialized.

Guidelines for using GOLDMINE

If it is a local number nnnnnnn then GOLDMINE stores it in the format (aa)nnn-
nnnn where aa denotes area code. For numbers other then local area numbers,
you need to enter them continuously without any special character such as - or (,
etc., for contact popup.

For example:
If your contact’s phone number is aa-nnnnnnn, where aa is the area code, you
need to enter it as aannnnnnn in GOLDMINE.
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Make sure to enter the correct GOLDMINE EXE file as the username and password
are passed along with it. If you enter any other EXE file there is a chance of the
program crashing.

11.1.3 Smart Control Network V4.1 as DDE Client to SuperOffice

If you have enabled DDE and selected SuperOffice4.0 as your PIM, you need to
enter the path for the SUPEROFFICE file, SUPEROF4.EXE. (If you are not sure
about the path of the file, run it by pressing the TEST button.) Even if you have not
logged on to SuperOffice it still shows the contact pop up.

Guidelines for using SuperOffice4.0
1.If your contact’s local area is the same as yours, you need to enter only the
number.

2.SuperOffice doesn’t show a popup for numbers having more than eight digits.
If you have entered the number in the form aannnnnnn, where aa indicates the
area code, then you cannot view the popup.

Note for users in Norway:
Norwegian users must always enter the area code (aa) before the phone number.
For example, if the number is nnnnnn then they need to enter it as aannnnnn.
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11.1.4 Smart Control Network V4.1 as DDE Client to Maximizer for
Windows

If you have enabled DDE and selected Maximizer for Windows as your PIM, you
need to enter the path of the Maximizer EXE file, MAXWIN.EXE. (If you are not
sure about the path of the file, run it by pressing the TEST button.)

When you click OK on the Select the DDE Server dialogue box, DDE is initialized
with Maximizer as the DDE server.

Guidelines for using Maximizer for Windows

If you have entered a username and password to access the database in Maximizer,
then Maximizer must be running prior to initialisation of DDE.

Maximizer only points to the contact’s record. The contact’s record is not popped
up. It is better to keep the Maximizer application maximized in the background.
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11.2 Note for All PIMs (Symantec ACT!,
GoldMine, SuperOffice, Maximizer)

If you get the following error when you select any of the above PIMs, it means that
DDE has not been initialized.

Smart Control

& Selected DDE application flepath incormect, check [Option][DDE..] menu

Figure 11-5

The solution is to run the EXE file for the application you have selected. Go to
Options/Set Environment --> DDE... and enter the path of the program file and
database file correctly. Then click OK on the dialogue box to reinitialize DDE.
Remember, if you simply click OK on the error message box (above), you cannot
see a contact popup for incoming calls as DDE is not initialized.

If you close Smart Control with DDE enabled, then when you start Smart Control
again, DDE is initialized automatically.
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11.3 General DDE Support

Smart Control Network V4.1 can work with other applications acting as DDE
servers. Select the Other option in the DDE Program combo box (Figure 11-2) if
you want to select an application other than that already selected.

The following steps explain how to use this feature.

Select the Other option in the DDE Program combo (dropdown list) box on the
Select the DDE Server dialogue box.

A help dialogue box appears (shown below) giving instructions you should follow.

Important Checks for Other DDE application

Ensure vour selected DDE application is running.
Enzure file [if any] of contact records is opened.
Replace "SMH" with DDE application's Service Mame.
Replace "TH" with DDE application's Topic Mame.
Replace "CMD" with DDE application's command.

=E S

Replace phone digits with "CLID" in the command.

Figure 11-6

Run your selected DDE application (server) EXE file.
Open the file of contacts (if any) in your DDE application (server).
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Enter your selected DDE application’s Services Name and Topic Name, and the
command which replaces SN@TN@CMD in the Command edit box. Replace the
phone digits in the command with “CLID”. Figure 11-7 shows how the dialogue
box would appear when Microsoft Access is selected as the other DDE application
(server).

Select the DDE Server (%]
Enable DDE ————— Search
¥ Far Incoring [ntemal Calls @ szing Caller's 1D

V¥ Far Incoming Extemal Calls " Using DMIS

— DDE Program

Program: IDther j AiEst |
Path: IE:\AETWINZ\QETWINZEXE Brawse.. |

SMETNECMD
Command: [MSACCESS@System@{0penFom LOG,. telNo="CLID"] [=|  _Fomat.. |

- Databasze File

Path: IE:\AETWIN2\DATABASE\M_l,lFirst.dbf Erowse,.. |

0k I Cancel Help |

Figure 11-7

Here MSACCESS@System(@|OpenForm
FORMNAME,,,FORMFIELD="CLID] is entered instead of SN(@TN@CMD.

Where,
SN-is Services Name(for Access it is MSACCESS).
TN- is Topic Name(for Access it is System).
CMD- is command(for Access it is [OpenForm
FORMNAME,,,FORMFIELD="“CLID"] ).

FORMNAME-The name of the form in Access.
FORMFIELD-The name of the field in the form that contains the phone digits.
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For eg:

MSACCESS@System@]|OpenForm LOG,,,telNo="CLID”]

here, LOG is the form name & telNo is the field in this form containing the phone
digits.

Click the Format button and enter the different phone number formats (based on the
number of phone digits) in the Phone Number Formats dialogue box.

Phone Number Formats E

—Format bazed on number of digits.

Enter the different phone number formats as expected by your
selected DDE application.

Fdigitz.  |==x 4 digits, |

B digitz.  [sxxs B digits, |xeex

7 digitz.  [sxmmmss 8 digitz.  |ssmms

9 digits, | srmmmz 10 digits. |HrrsrErEss

11 digits. [ 12 digits.  |sssssmmnmmmm

LR

13 digits, | HRREEEEEEREES 14 digits,  |sessmsEEEE

I

Figure 11-8

The dialogue box shown above displays the default formats for the various sizes of
phone numbers.

The formats you enter should match the formats in your selected DDE application
(server). This is necessary as different PIMs store the phone numbers in different
formats depending upon the number of digits in the phone number. For example, In
Symantec ACT! 2.0 the number is stored in xxx-xxx-xxxxxx format. The number
2004 is thus stored as 200-4.
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Smart Control Network V4.1 needs to know in what format the phone digits are
stored in the selected PIM depending upon the number of digits. Smart Control
Network V4.1 formats the number according to the format entered above and sends
it to the PIM for a search.

Click OK on the Select the DDE Server dialogue box. If the following error
message box appears, check if your selected DDE application is running.

SmartControl [ =]

Selected DDE application iz not running or DDE command is nat
proper. Check the DDE properties under [0 ption]/[Set
Environment-> DDE. ] menu item

Figure 11-9

The error signifies that DDE is not initialized with your selected DDE application

(server).
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11.4 Smart Control Network V4.1 as DDE Server

Smart Control Network V4.1 as DDE server supports only the “SmartControl”
Services Name and “Telephony” Topic Name. Any client PIM can place a call
using Smart Control Network V4.1. The client application needs to send the
command as “MakeCall XYZ” after starting the conversation using “SmartControl”
as the Services Name and “Telephony” as the Topic Name.

For example
A user of SuperOffice PIM can place a call using Smart Control Network V4.1. The

following command needs to be entered in the “Prefix” field of the Dial dialogue
box in SuperOffice:
DDE;SmartControl; Telephony;MakeCall XYZ

where XYZ is the number that is to be dialed.
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12. Limitations

1. When the Selection View is hidden, you cannot switch between the services or
the phone books.

2. Phone book name can be maximum of 10 characters and cannot have spaces in
the name.

3. For network data connection, validity of the database file for the network
database is verified only after the connection is made.

4. Default phone books cannot be renamed. (In Icon view it appears as though
names can be changed, i.e. if you click on the title of the icons it allows you to
edit the name. However, after editing, the old name is retained.)

5. Ifthere is(or are) already any call(or calls) at your phone and then you start
Smart Control Network V4.1, you can only view these call states using Smart
Control Network V4.1’s Call View. Some Call Control can be enabled or
disabled. You must always start Smart Control Network V4.1 with no calls at
your station(phone).

6. Smart Control Network V4.1 cannot be run at Windows 3.1 or DOS
Environements. It can be run only at Windows 95, 98 and NT Workstation, NT
Server 4.0 with Service Pack 4 or later.

7. Smart Control Network V4.1 and Samsung Tapi2.1 Telephony Service
Provider can be used only for Samsung Key Telephony System Series.

8. Without the Dongle supported by Samsung Electronics Co., Ltd, Smart Control
Network V4.1 and Samsung Tapi2.1 Telephony Service Provider will not run.

Microsoft Windows 95 and Windows NT are registered trademarks of Microsoft.
Other brand or product names are trademarks or registered trademarks of their
respective holders.
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